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Preface

This chapter contains the following information:

• About Instructions for Use on page xii

• Conventions on page xiii

• Technical Assistance on page xv

• Intended Use for Outside US on page xv

• Intended Use for US on page xv
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About Instructions for Use

This document contains the information necessary to operate your 
BD FACSCanto™ II flow cytometer. Most cytometer functions are controlled by 
BD FACSCanto™ clinical software and BD FACSDiva™ software. 
BD FACSCanto clinical software contains modules for dedicated clinical 
applications with automatic gating algorithms, while BD FACSDiva software is 
non–application specific. Use BD FACSCanto clinical software for performing 
cytometer quality control. 

BD Biosciences recommends that first-time users of this cytometer take 
advantage of operator training offered with the sale of every new cytometer.

The BD FACSCanto II Instructions For Use assumes you have a working 
knowledge of basic Microsoft® Windows® operation.

For US: 

Caution: Federal Law restricts this device to sale by or on the order of a licensed 
practitioner.
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Conventions

The following tables list conventions used throughout this guide.

Table 1  Hazard symbols

Symbola

a. Although these symbols appear in color on the cytometer, they are in black and white throughout this 
document; their meaning remains unchanged.

Meaning

Caution: hazard or unsafe practice that could result in material damage, data 
loss, minor or severe injury, or death

Risk of electric shock

Laser radiation

Biological risk

Table 2  Text and keyboard conventions

Convention Use

NOTE Describes important features or instructions

Italics Italics are used to highlight book titles and new or unfamiliar 
terms on their first appearance in the text. 

Bold Bold text indicates software elements such as windows, 
menus, buttons, and tabs that are used to complete tasks.

> The arrow indicates a menu selection. For example, “select 
File > Print” means to select Print from the File menu.

Ctrl+X When used with key names, a plus sign means to press two 
keys simultaneously. For example, Ctrl+P means to hold down 
the Control key while pressing the letter p. 



xiv BD FACSCanto II Instructions For Use   

For US:

Symbol Meaning

Caution: Federal Law restricts this device to sale by or on the order of a 
licensed practitioner. Rx Only
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Technical Assistance

For technical questions or assistance in solving a problem:

• See the Troubleshooting section.

• See the BD Biosciences website: bdbiosciences.com

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

When contacting BD Biosciences, have the following information available:

• Product name, part number, and serial number; software version and 
computer system specifications

• Error messages, if any

• Details of recent cytometer performance

For support from in the US and Canada, call 877.232.8995.

Customers outside the US and Canada, contact your local BD representative or 
distributor.

Intended Use for Outside US

The BD FACSCanto II system is intended for use as an In Vitro Diagnostic device 
for identification and enumeration of lymphocyte subsets in human cells in 
suspension.

Intended Use for US

The BD FACSCanto II flow cytometers (4-2-2 and 5-3 configurations) function 
as part of a system with dedicated clinical software intended for use with cleared 

http://www.bdbiosciences.com
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or approved in vitro diagnostic (IVD) assays that are indicated for use with the 
instrument for the identification and enumeration of human cell subsets. Only six 
detection channels using a blue (488 nm) and a red (633 nm) laser have been 
cleared for in vitro diagnostic use. For use with or without the BD FACS™ 
Sample Prep Assistant III.

For in vitro diagnostic use.

Intended Use for US

The BD FACSCanto II flow cytometer (4-2 configuration) is intended for use as 
an In Vitro Diagnostic device for identification and enumeration of lymphocyte 
subsets in human cells in suspension. 

• Immunophenotyping in clinical laboratories, using previously cleared in 
vitro diagnostic assays for flow cytometry.

• Identification and enumeration of lymphocyte subsets in human cells in 
suspension.

• For in vitro diagnostic use.

• For use with or without the BD FACS Sample Prep Assistant III
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System Overview

This chapter contains the following information:

• System Components on page 18

• BD Applications Running in Windows 10 OS on page 30

• System Requirements on page 31
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System Components

The BD FACSCanto II system consists of a flow cytometer, a self-contained 
fluidics cart, and the BD FACSCanto II workstation. System options include an 
automated sample loader and a barcode reader.

Flow Cytometer

Figure 1-1  Flow cytometer components

Do not place heavy objects on top of the cytometer at any time. Doing so 
could cause alteration of data.

Data ports

Side door

Flow cell
access door

Optics
access door

Sample 
injection 
tube

Fluidics cart
connections

Power button

Acquisition 
indicator lights
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Fluidics

When you install tubes onto the sample injection tube (SIT), a pump within the 
fluidics cart pressurizes the plenum, which then provides sheath fluid to the flow 
cell. At the same time, the sample tube is pressurized and sample is pushed up the 
SIT and into the flow cell.

When you remove tubes from the SIT, the cytometer cleans the SIT by flushing 
sheath solution down the inside and outside of the tube. The flushed sheath 
solution is aspirated by the aspirator arm.

SIT cleaning between tubes is automatic when you use BD FACSCanto clinical 
software. In BD FACSDiva software, SIT cleaning between tubes is automatic 
unless you disable it by clearing the SIT Flush checkbox on the Acquisition 
Dashboard.

Aspirator arm

Tubing

Aspirator arm bar

Flow cell

Tube guide 
(Loader option only)

Sample injection tube (SIT)

Tube eject cylinder
(used with 
Loader option only)

Tube sensor
Bal seal access



20 BD FACSCanto II Instructions For Use   

Optics

Once the sample moves into the flow cell, particles move in single file through the 
laser beams. The scattered and emitted light from these particles provides 
information about their size, shape, granularity, and fluorescence properties. 

From the flow cell, laser-excited and scattered light is routed to the detector 
arrays, which consist of photomultiplier tubes (PMTs) arranged in one octagon 
and one trigon.

The octagon contains five PMTs and detects light excited and scattered by the 
488-nm (blue) laser. One PMT in the octagon collects side scatter (SSC) signals.

FSC diode

Where lasers 
intercept
sample stream

Obscuration
bar

Flow cell
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Figure 1-2  Trigon and octagon detector arrays (4-2 configuration)

Longpass 
mirror

Bandpass 
filter

Red-laser 
signal

Trigon

Octagon

Blue-laser 
signal

PMT
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Blank optical holders do not contain optical filters. They are used in the octagon 
and trigon to prevent unwanted light from interfering with fluorescence signal.

Detector Array 
(Laser)

PMT
Position

LP Mirror
BP Filter or 
LP Mirror

Intended Dye

Octagon 
(488-nm blue 
laser)

A 735 780/60 PE-Cy™7

B 655 670 PerCP-Cy™5.5 
or PerCP

C 610 Blank 
optical holder

—

D 556 585/42 PE

E 502 530/30 FITC

F Blank 
optical holder

488/10 
and pinhole

SSC

G Blank 
optical holder

Blank 
optical holder

—

H — Blank 
optical holder

—

Trigon 
(633-nm red laser)

A 735 780/60 APC-Cy7 

B 685 Blank 
optical holder

—

C — 660/20 APC
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Electronics

Power to the cytometer, lasers, and fluidics cart is supplied by a power cord from 
the cytometer plugged directly into a standard electrical outlet. We recommend 
using an uninterruptible power supply (UPS) unit to maintain cytometer power 
during a power outage. The system power button turns on the cytometer and 
fluidics cart, and powers the lasers.

NOTE If a power failure occurs during a run, sample can leak from the SIT. To 
prevent a biohazardous spill, place an empty tube on the SIT. Once power is 
restored, remove the tube and perform a fluidics startup before resuming the run.

Figure 1-3  Flow cytometer power panel 

The system circuit breaker is located next to the AC power cord. The breaker will 
need to be reset if there is a power surge in the laboratory.

Acquisition indicator lights are located on the flow cell access cover on the front 
of the cytometer (see Figure 1-4 on page 24). Each light corresponds to a detector 
in the collection optics subsystem, and blinks when the signal at that detector 
reaches a preset level. Acquisition threshold levels (set using the software) 
override the presets.

Lights are activated only when the system is acquiring data, and only the 
indicators corresponding to currently active parameters will blink.

System circuit breaker

System power 
button

stem AC power 
rd plugs in here

Power out to 
fluidics cart

Communication 
cable to fluidics cart
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Figure 1-4  Detector order of acquisition indicator lights

The acquisition indicator lights can be switched off. The on/off switch is located 
inside the flow cell access cover.

Figure 1-5  Acquisition indicator light switch
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Fluidics Cart

The fluidics cart provides filtered sheath and cleaning fluids to the cytometer, and 
collects system waste products. The cart supplies the required air pressure and 
vacuum, which eliminates the need for an external source (although the cart can 
be hooked up to an in-house air source).

Figure 1-6  Fluidics cart

10-L waste 
container

BD FACSFlow 
cubitainer

Door access 
knob
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Containers and Ports

BD FACSFlow 
cubitainer

BD FACS shutdown solution 
port and cubitainer

BD FACS cleaning solution 
port and cubitainer

Waste 
container

Waste 
port

Fluidics filters

BD FACSFlow port
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Controls

The fluidics cart connects to the flow cytometer unit by way of cables and tubing. 
When you turn on the power to the cytometer, the fluidics cart powers on also. 
Under ordinary circumstances, you do not need to adjust any of the switches on 
the cart’s power panel. Leave the auxiliary air supply switch off unless the cart 
has been attached to an in-house air supply by BD Biosciences service personnel. 
Leave the cart circuit breaker on at all times.

Figure 1-7  Fluidics cart panel

Condensation Trap

The fluidics cart condensation trap is located beneath the controls panel (). 
Empty the trap during the daily shutdown procedure.

Air Pressure

     Auxiliary
Air Supply  (J)

On  (I)

Off  (O) Air In (F)

Air Out (G)Fluid (B)Circuit Breaker (T)

Voltage Selector (U)

Power (H)

Com (K)

Power from
Instrument
Power out only!

Waste (A)Waste (A)

Waste (A)Waste (A)

Cart circuit breaker

Condensation trap

Auxiliary air supply 
switch
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BD FACS Loader (Optional)

The BD FACS™ Loader (Loader) automatically introduces prepared samples to 
the cytometer. The Loader is controlled by BD FACSCanto clinical software or 
BD FACSDiva software.
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Carousel

The carousel accommodates up to forty 12 x 75-mm tubes. Each carousel has a 
unique ID printed on top and on an optically read label inside.

Figure 1-8  Sample-Prep Ready carousel

NOTE The Loader is compatible only with the green-tinted carousels labeled 
Sample Prep Ready.

Not all manufactured 12 x 75-mm tubes have been checked for proper 
functionality on the Loader. BD Biosciences has validated only disposable, 
12 x 75-mm Falcon® polystyrene test tubes, BD Trucount™ tubes, and 
BD FACS™ 7-color setup bead tubes.

Alignment hole

Spindle hole
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Barcode Reader (Optional)

The barcode reader is a hand-held device that plugs into the USB port on the 
BD FACSCanto workstation. The barcode reader reads most barcode standards, 
including Codabar, Code 128, Code 39 with checksum, and Interleaved 2 and 5. 
It reads information from the BD FACS 7-color setup beads label into 
BD FACSCanto clinical software, as well as coded patient information into a 
worklist.

For detailed information including how to program the barcode reader for other 
barcode standards, refer to the manufacturer’s documentation.

BD Applications Running in Windows 10 OS

BD FACSDiva software version 9.0 and BD FACSCanto clinical software version 
4.0 run in the Microsoft Windows 10 64-bit operating system. The applications 
will not run in older versions of the Windows operating system. 

The basic functionality of the applications remains the same as in the previous 
versions.
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System Requirements

Software

Both included software packages must be installed:

• BD FACSCanto clinical software version 4.0 or later

• BD FACSDiva software version 9.0 or later

Workstation

BD FACSCanto II workstation purchased through BD Biosciences

Compatible Tubes

• 12 x 75-mm polystyrene test tubes (Falcon tubes)

• 12 x 75-mm BD Trucount tubes

• BD FACS 7-color setup bead tubes

FCS files created with BD FACSCanto clinical software version 2.4 or later 
cannot be used with an earlier version of BD FACSCanto clinical software. 
Earlier versions will show incorrect results.
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Bulk Fluids

• BD FACSFlow™ solution

• BD™ FACSClean solution

• BD FACS™ shutdown solution

• Bleach (waste container)

Fluids Required for External Cleaning

• BD FACSClean solution

• Deionized (DI) water

Setup Beads

BD FACS 7-color setup beads for use with BD FACSCanto clinical software
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Software Windows and Toolbars

This chapter contains information about the following software:

• BD FACSCanto Clinical Software Workspace on page 34

• BD FACSDiva Software Workspace on page 36
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BD FACSCanto Clinical Software Workspace

After you log in, the main window appears. Table 2-1 provides a brief overview 
of window components.

Table 2-1  Main window components

Number Component Function

1. Menu bar Contains the File, View, Worklist, Cytometer, Tools, and 
Help menus

2. Toolbars Contains buttons that provide quick access to menu 
commands. See BD FACSCanto Toolbars on page 35.

1

3

5

6

7

8

9

2

4
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BD FACSCanto Toolbars

3. Workspace Displays the Worklist, Acquisition, Lab Report, and Levey-
Jennings tabs, depending on where you are in the workflow

4. Status bar Provides information about the flow cytometer’s current 
state, the cytometer-software connection, and the amount 
of time elapsed since login

5. Minimize, 
Maximize, 
and Close 
buttons (in 
title bar)

Minimize button. Reduces the application to a button on 
the Windows taskbar

Maximize button. Fills the screen with the main window

Close button. Exits the application and prompts the 
Fluidics Shutdown procedure

6. Carousel 
window

Shows a graphic representation of a carousel rack and the 
rack ID of the currently selected sample

7. Status 
window

Provides information on the current status of the flow 
cytometer

8. Cytometer 
control 
windows

Include three tabs:

• Detectors tab

• Thresholds tab

• Spectral Overlap tab

9. Docking area Provides a default home for the Carousel, Status, and 
Cytometer Control windows

Table 2-1  Main window components (continued)

Number Component Function

OptimizeLogout New acq. 
worklist

New anal. 
worklist

Open 
worklist

Save Print Run Pause Stop Skip End 
recording

Standard toolbar Worklist toolbar



36 BD FACSCanto II Instructions For Use   

BD FACSDiva Software Workspace

After you log in, the workspace appears, showing the main application windows 
(Figure 2-1). 

Figure 2-1  BD FACSDiva workspace

Number Description

Click a button on the Workspace toolbar to hide or show the corresponding 
window. Most windows can be resized by dragging a border or corner.

1

2

4

3

5

6

1
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The Browser lists folders, 
experiments, and experimental 
elements in a hierarchical view, 
provides an interface for setting up 
experiments, and contains a current 
tube pointer (c) indicating the tube 
for which acquisition or analysis 
data will be shown.

Only one experiment can be open at 
a time. In an open experiment, you 
can add, rename, or copy elements, 
and record or display data.

Click a button on the Browser toolbar (a) to add elements to the Browser. To 
display a particular experiment, enter a term in the search field (b) and click 
the Find button (d).

The Cytometer window shows the 
cytometer connectivity status. When 
the cytometer is connected, the window 
also shows status messages. If an 
experiment is open and the current tube 
pointer is set, the window displays 
cytometer settings for the current 
acquisition tube and laser controls. 

Number Description

2

a

c

b

d

3
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Use the Inspector to view or modify the 
attributes of one or more objects in the 
worksheet or Browser. The contents of 
the Inspector change depending on 
what is selected. For example, this 
Inspector shows plot options.

The Worksheet window is where you create global or normal worksheets 
containing plots, gates, statistics, and custom text.

Plots on a global worksheet show data for the tube selected with the current 
tube pointer. Global worksheets are indicated by green tabs (b). Plots on a 
normal worksheet are tube specific. Normal worksheets are indicated by 
white tabs for active worksheets and gray tabs for inactive worksheets.

Click the button on the Worksheet toolbar (a) to switch between the global or 
normal worksheets view. Then you can create analysis objects or text, or align 
objects on a worksheet.

Number Description

4

 

5

a

b
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The Acquisition Dashboard contains controls for setting up, starting, 
monitoring data acquisition and recording, and running the Loader. Basic 
controls are always shown. Carousel Controls (a), Acquisition Setup (b), and 
Acquisition Status (c) can be hidden or shown by right-clicking anywhere on 
the Dashboard (except buttons and fields or in Basic Controls) to display the 
Show/Hide menu and making your selection. You can resize the Dashboard by 
dragging an edge or corner of the window. 

Unlike other workspace windows, the 
Biexponential Editor is hidden by 
default. When you are using automatic 
scaling, there is no need to show the 
Biexponential Editor.

Use the Biexponential Editor to 
manually adjust biexponential scales, 
export and import scale values, and 
apply values to other elements in an 
experiment.

Number Description

6

a

c

b

 



THIS PAGE INTENTIONALLY LEFT BLANK



41
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Barcode Reader Option

This chapter provides the following barcode information:

• Installing and Using the Barcode Reader on page 42

• Cleaning the Barcode Reader on page 45

• Barcode Symbologies on page 45
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Installing and Using the Barcode Reader

The handheld barcode reader plugs into the USB port on the system computer 
workstation. The barcode reader reads most current barcode standards. See the 
manufacturer’s documentation for details on safety, how to use the reader, 
maintenance, and for the complete list of standards.

When to Use the Barcode Reader

Use the barcode reader to scan the following labels when using the BD 
FACSCanto system:

• BD FACS 7-color setup beads label

• Sample ID label on sample tube

NOTE Only use the barcode reader that is supplied with your instrument to 
perform these tasks.

Scan window

Scan trigger

LED indicators
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Important Barcode Reader Information

• Contact BD Biosciences before changing default barcode settings.

To prevent laser injury, do not stare into the beams or aim the scanner at 
another person’s eyes while the trigger is depressed.

For accurate results, do not photocopy or enlarge the barcodes that are 
included with the reagent. Scan the barcodes exactly as they are provided.
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Barcode Label Specifications

The following table lists the details for barcode labels that are used on tubes.

Specification Description

Supported symbologies (types) Code 128, Code 39, Codabar, Interleaved 
2 of 5

You do not need to specify the type of 
symbols for labels on tubes. The barcode 
reader can sense differences automatically.

Narrow element (width of the narrowest 
bar in a label)

10 mil (0.25 mm, 0.01 in.) or greater

Dimensions a - Max label length: 44.45 mm (1.75 in.) 
This length should include the barcode 
symbol and quiet zone.

b - Max label height: Cannot exceed 
20 mm more than the circumference of 
the tube.

c - Max symbol length: 37.45 mm 
(1.47 in.)

d - Minimum symbol height: 19.05 mm 
(0.75 in.). We recommend the maximum 
symbol height possible because this makes 
it easier to orient tubes within a rack. 

e - Minimum quiet zone: 3.5 mm 
(0.14 in.) at each end of the symbol.

Human readable f - Size and placement of the human 
readable to be determined by the user.

Label thickness Thickness of label and adhesive not to 
exceed 3.9 mil. (0.099 mm, 0.0039 in.)

Finish Print labels on material with a matte 
finish.

0001
f

a
c

d bee
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Cleaning the Barcode Reader

For best performance, keep the front window of the barcode reader clean. Do not 
touch the window directly, and wipe it only with a soft, non-abrasive cloth 
moistened with one of the following:

• Isopropyl alcohol

• Ethyl alcohol (denatured grade)

Barcode Symbologies

Checksums

Although data entry using barcodes is generally more reliable than manual data 
entry, it is not guaranteed to be 100% accurate. By default, the barcode reader 
has checksums enabled. To increase accuracy, we recommend you do not disable 
checksums, or use barcode symbologies without checksums.

Placement of label on tube The label must be placed a minimum of 
12 mm (0.47 in.) from the bottom of the 
tube. The label must be placed so the bars 
are perpendicular to the length of the 
body of the tube. 

Do not use BD FACS™ cleaning solution or bleach to clean or disinfect the 
barcode reader.

Using barcode symbologies with checksums disabled increases the 
likelihood of incorrect information transfer, including sample ID 
assignments. This can result in a mismatch of sample IDs and sample 
results.

Specification Description
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1D Barcode Symbologies

BD Biosciences has evaluated the following 1D barcode symbologies for use with 
the BD FACSCanto II flow cytometer, and has the following recommendations.

2D Barcode Symbologies

BD Biosciences has evaluated 2D barcode symbology to read the target values of 
BD FACS 7-color setup beads when using BD FACSCanto clinical software. 2D 
barcode symbology must be installed in order to read all target values with one 
scan.

Label Recommendations

Observe these recommendations for optimal performance.

• Labels must be clean and not yellowed.

• Use labels prior to expiration date.

• Label must not have defects such as spots, lines, missing sections, cuts, 
folds, or density problems.

Barcode Symbology Recommendation

Code 128 Preferred.

Code 39 Acceptable if barcode labels are printed with the checksum 
digit. By default, the barcode reader recognizes the checksum 
digit when reading the Code 39 symbology. However, if labels 
are printed without a checksum digit, contact your BD service 
representative for instructions on disabling the checksum 
feature.

Codabar The barcode reader does not support the checksum feature 
when reading the Codabar symbology.

Interleaved 2 of 5 Acceptable
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• Bars must be well defined and bar edges must not be irregular.

Barcode Error Rate Guidelines

• Code 128 and 39 are more accurate and have lower error rates than 
Codabar and Interleaved 2 of 5.

• CLSI recommends Code 128 because of its accuracy, compact form, and 
self-checking capabilities.

• A checksum greatly increases accuracy. If possible, use a checksum with 
Codabar and Interleaved 2 of 5 because they are less accurate symbologies.

• If available, select the fixed length option since this is more accurate than 
variable length.
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Starting Up

This chapter provides the following information on how to start up the 
cytometer, BD FACSCanto clinical software, and BD FACSDiva software:

• Starting the System on page 50

• Checking Fluid Levels on page 51

• Checking for Air Bubbles on page 53
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Starting the System

1 Turn on the power to the cytometer.

Figure 4-1  Flow cytometer power panel

The system power button turns on power to the cytometer, fluidics cart, 
and lasers.

2 Start up the computer, start the software, and log in.

3 Make sure the software is connected to the cytometer.

System power button
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If needed, click Cytometer > Connect.

Checking Fluid Levels

1 After startup, check fluid levels.

A low fluid level or a full waste container is indicated in red.

BD FACSCanto

BD FACSDiva
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2 If fluidics startup does not start automatically, click Cytometer > Fluidics 
Startup.

3 Click OK at the confirmation dialog.

4 When Fluidics Startup finishes, click OK to close the dialog.

To prevent fluid overflow, make sure there is no tube on the SIT at startup.

FACSFlow

BD FACSCanto 

BD FACSDiva

Waste

Shutdown solution

Cleaning solution (empty)
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Checking for Air Bubbles

1 After checking fluid levels, lift the flow cell access door to check the flow 
cell for air bubbles.

Figure 4-2  Flow cell

2 If you don’t see air bubbles, go to step 5. If you see bubbles, click 
Cytometer > Cleaning Modes > De-gas Flow Cell.

3 Click OK when the completion message appears.

4 If you still see bubbles, repeat.

NOTE If an error message appears when you open the flow cell access 
door, close the message by closing the door and waiting 30 seconds.

5 When you are done, confirm that laser warmup has finished before 
proceeding.

Check here for bubbles

BD FACSCanto

BD FACSDiva



THIS PAGE INTENTIONALLY LEFT BLANK



55

5

Cytometer QC and Setup

This chapter provides the following information on how to perform cytometer 
QC and setup:

• Performing Automated Setup on page 56

• Running Setup Using Manual Loading on page 57

• Running Setup Using the Loader on page 66
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Performing Automated Setup

Whether you run samples in BD FACSCanto clinical software or BD FACSDiva 
software, use BD FACSCanto clinical software to run automated setup and QC.

During setup, detector voltages are adjusted to place setup beads at defined target 
values, sensitivity values are measured, and spectral overlap values are calculated 
and applied to compensate data for fluorescence spillover. Use the Levey-Jennings 
feature in BD FACSCanto clinical software to automatically track cytometer 
setup values over time, and to monitor cytometer performance and see shifts or 
trends in parameters as they occur. 

Run setup once every 24 hours, using BD FACS 7-color setup beads. The 
software tracks the time between setups and displays it in the Status window. A 
setup age of more than 24 hours appears in red. Running a successful setup resets 
the timer. 

Time since 
last setup
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Running Setup Using Manual Loading

1 Prepare BD FACS 7-color setup beads (see the instructions supplied with 
the beads).

2 Prepare the cytometer for manual loading.

Do not use beads that have passed their expiration date. Doing so can cause 
incorrect setup results.

Tube guide pushed back

Aspirator arm bar vertical

Drawer pulled out

Carousel removed

1

2

3

4

3

4

2

1
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3 Select Cytometer > Setup > Standard Setup to open the Cytometer Setup 
Wizard.

4 Select the current bead lot from the Lot ID menu.

Figure 5-1  Setup Lot Information window

5 Check lot ID, targets, and spectral overlap factors in the Setup Lot 
Information window against the BD FACS 7-color setup beads label.

See Figure 5-2 on page 59 for an example BD FACS 7-color setup beads 
label.
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Figure 5-2  Setup beads label (example)

6 If necessary, enter new values.

• To enter values using the barcode reader, go to the next section.

• To enter values using the keyboard and mouse, go to page 61.

7 If you do not need to enter new values, click Next and go to Loading and 
Running Beads Tubes (Manual) on page 62.
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Entering Lot Information with the Barcode Reader

Although data entry using barcodes is generally more reliable than manual data 
entry, it is not guaranteed to be 100% accurate. To increase accuracy when using 
the barcode reader, enabling the checksum feature is recommended. For more 
information on using the barcode reader, see Chapter 3.

1 Click Scan Barcodes in the Setup Lot Information window of the Wizard 
(Figure 5-1 on page 58).

The Scan Barcode dialog opens.

2 Locate the barcode on the BD FACS 7-color setup beads label. See 
Figure 5-2 on page 59.

3 Hold the barcode reader 23 cm (9 in.) from the BD FACS 7-color setup 
beads label and aim the barcode reader at the center of the barcode.

4 Press and hold the trigger on the barcode reader until you hear a beep. 

The progress bar fills and the dialog closes when you successfully scan the 
barcode.

If the reader does not beep, adjust your distance from the barcode while 
continuing to hold the trigger.

5 Check software entries for accuracy of reading the setup beads label.

6 Go to Loading and Running Beads Tubes (Manual) on page 62.

To prevent laser injury, do not stare into the beams or aim the scanner at 
another person’s eyes while the trigger is depressed.
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Entering New Lot Information with the Keyboard

1 Click New Lot ID in the Setup Lot Information window of the Wizard 
(Figure 5-1 on page 58).

2 Select the bead product, enter the lot ID and the expiration date from the 
setup beads label, and click OK.

3 Enter the target values for the bead lot. Select the current value in the 
Target Value field and enter the new value. Repeat until you have edited all 
target values.

4 Click the Spectral Overlap Factors tab, and enter the spectral overlap 
factors for the bead lot.

Select a current value and enter the new value. Repeat until you have edited 
all spectral overlap factors.

Do not use the barcode on the tube. 
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5 Click Next and go to Loading and Running Beads Tubes (Manual).

Loading and Running Beads Tubes (Manual)

1 Click Next.

2 If you changed Lot ID values and the Save Setup Bead Lot Info dialog 
appears, click Yes.

3 Select Run setup in Manual mode, and click Next.

4 When prompted, load the beads tube onto the SIT, using these steps:

a Push the aspirator arm to the left.

b Place the beads tube on the SIT, ensure the tube is straight, and firmly 
push up until the tube comes to a complete stop and is fully seated.

c Center the aspirator arm under the beads tube. There are three sensor 
pins on the aspirator arm. The bottom of the tube should sit within the 
center of the pins.

5 Click OK and wait for setup to finish.

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.
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The software adjusts cytometer settings to place the beads on scale. Note 
that it is normal for the beads to move to the baseline and back on scale 
during this process.

6 Unload the beads tube when prompted, using these steps:

a Hold the sample tube while pushing the aspirator arm to the left.

b Remove the tube from the SIT.

c Release the aspirator arm.

A SIT Flush occurs when the aspirator arm comes to center.

Symbols key

Completed

Not done

In process
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Accepting and Managing Setup Information 
(Manual)

Figure 5-3  Successful Setup Complete dialog

If setup is successful, see Table 5-1 on page 65.

Incorrect values are saved if you accept a setup that is unsuccessful or setup 
results that are out of range. If setup is unsuccessful or if setup results are 
out of range, do not click Finish. Note the message provided by the 
software (for example, Figure 5-3) and consult BD FACSCanto Clinical 
Software Troubleshooting on page 196.
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Table 5-1  Options after setup

NOTE It is important to monitor setup data for trends. See Reviewing Levey-
Jennings Reports on page 79.

Task Button Additional Information

View setup results View Setup 
Report

The report contains cytometer QC 
and pass/fail information. You can 
print the report from this view.

Discard current results Cancel You will be given the option to use 
the last setup results.

Run setup again Back

Optimize setup values 
using BD FACSCanto 
clinical software

Next

When prompted, 
click Yes to save 
your results and 
continue.

Proceed to Optimizing with 
BD FACSCanto Clinical Software 
on page 70.

Exit setup and save new 
setup results

Finish The software calculates and saves 
lyse/wash and lyse/no-wash setups 
that you can use with 
BD FACSCanto clinical software or 
BD FACSDiva software. PDF files of 
Setup Reports are automatically 
saved in the D:\BD\FACSCanto\ 
SetupReports folder.

(Optional) Save setup 
results and optimize 
setup values using 
BD FACSDiva software

Finish Proceed to Optimizing with 
BD FACSDiva Software on 
page 102.
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Running Setup Using the Loader

1 Prepare BD FACS 7-color setup beads (see the instructions supplied with 
the beads).

NOTE Do not use beads that have passed their expiration date. Doing so 
can cause incorrect setup results.

2 Prepare the cytometer for automatic loading (Figure 8-3 on page 134).

3 Select Cytometer > Setup > Standard Setup to open the Cytometer Setup 
Wizard.

4 Select the current bead lot from the Lot ID menu.

5 Check the Lot ID, Targets, and Spectral Overlap Factors in the Setup Lot 
Information window against the BD FACS 7-color setup beads label. 

6 If needed, enter new values and click Next.

See page 60 for how to enter information using the barcode reader.

7 If you changed Lot ID values and the Save Setup Bead Lot Info dialog 
appears, click Yes.

Loading and Running Beads Tubes (Loader)

1 Place the beads tube in position 1 of a carousel and the optimization tubes 
in the positions following.

For instructions, see step 3 on page 135.

2 Install the carousel onto the Loader.

For instructions, see step 4 on page 135 and step 5 on page 135.

3 Clear the Run setup in Manual mode checkbox, and click Next.
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4 Wait for setup to finish.

The software adjusts cytometer settings to place the beads on scale. Note 
that it is normal for the beads to move to the baseline and back on scale 
during this process.

Symbols key

Completed

Not done

In process
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Accepting and Managing Setup Information 
(Loader)

If setup is successful, see Table 5-1 on page 65.

NOTE It is important to monitor setup data for trends. See Reviewing Levey-
Jennings Reports on page 79.

Incorrect values are saved if you accept a setup that is unsuccessful or setup 
results that are out of range. If setup is unsuccessful or if setup results are 
out of range, do not click Finish. Note the message provided by the 
software (see Figure 5-3 on page 64) and consult BD FACSCanto Clinical 
Software Troubleshooting on page 196.
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6

Running Samples with
BD FACSCanto Clinical Software

This chapter provides the following information on how to use BD FACSCanto 
clinical software features to run and review worklist data: 

• Optimizing with BD FACSCanto Clinical Software on page 70

• Running an Acquisition Worklist on page 81

• Reviewing an Analysis Worklist on page 95

• Reviewing a Lab Report on page 97

• Running Cleaning Tubes on page 99

• Logging Out on page 100
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Optimizing with BD FACSCanto Clinical Software

During optimization, you can adjust thresholds, detector voltages, and spectral 
overlap values for a panel type. The software uses BD Biosciences default settings 
the first time you optimize. When you make changes, the new settings apply to all 
tubes and samples of the selected panel type. 

Acquiring Data and Optimizing Settings

1 Select a panel type and parameters from the menus and click Next.

NOTE The 4-color and 6-color TBNK panels are the same, with or 
without BD Trucount tubes.

Gate Parameter X and Gate Parameter Y refer to the plot parameters for 
the first optimization plot, the plot that contains a gate around the cells of 
interest.

2 (Loader only) Make sure the optimization tubes are installed in the correct 
carousel positions, and click Next.
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3 Click Next Tube.

4 (Manual only) Install the first optimization tube when prompted, and click 
OK.

5 In the Cytometer Setup Optimization window, click Start.

• Acquisition begins, and events appear in the plots. 

• Right-click the axis labels on a plot to select other parameters to be 
displayed.
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6 Optimize settings, as needed.

• To adjust the optimization gate, click Stop. The acquisition display 
stops updating. Move the gate by dragging the gate border, or resize the 
gate by selecting a corner and dragging. When you are ready to 
proceed, click Start.

• To adjust detectors, thresholds, or spectral overlap settings, click the 
corresponding tab and use controls in the tab to adjust the settings. For 
instructions, see Using Cytometer Controls on page 76.

Spectral overlap values are automatically recalculated when you adjust 
voltages.

NOTE Threshold and side scatter are the most frequently optimized 
parameters for TBNK assays.

For clinical applications that use tandem conjugates such as APC-Cy7 or 
PE-Cy7, spectral overlap varies from lot to lot. Because BD FACSCanto 
clinical software setup targets the average lot, you might need to adjust 
spectral overlap settings for these reagents. 
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7 If this is the last tube, proceed to Saving the Optimized Setup Results on 
page 74. Otherwise, continue to the following section.

Running Additional Optimization Tubes

1 Click Stop, and then Next Tube.

2 (Manual only) Remove the current tube when prompted, using the 
following method:

a When the aspirator arm lowers, hold your sample tube while you push 
the aspirator arm to the left.

b Remove the tube from the SIT.

c Release the aspirator arm.

SIT cleaning occurs when the aspirator arm comes to center.

NOTE To prevent backflow into the tube, follow the tube removal 
sequence exactly. For more information, see Cytometer Troubleshooting on 
page 183.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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3 (Manual only) When prompted, place the next tube on the SIT, and click 
OK.

4 Repeat steps 3 through 6 in the preceding section starting on page 71.

Saving the Optimized Setup Results

1 When there are no more tubes to optimize, click Stop, and then Save.

Optimized setup results are saved to the panel name.opt file in the 
C:\ProgramData\BD\Shared\Setup Results folder. (For example, 4-color 
TBNK optimized setups are saved to the 4 color TBNK.opt file and 6-color 
TBNK optimized setups are saved to the 6 color TBNK.opt file.)

The software also saves PDF files of the Application Setup Report.

2 Unload the optimization tube or remove the carousel.

3 Click Finish.

Viewing and Printing the Application Setup Report

The Application Setup Report reflects the optimized settings. You can view and 
print it before optimization is complete.

• From the Cytometer Setup Optimization window, click View Report.

• Click the Print button on the toolbar to print the report.

When setup results are saved, the software also saves PDF files of the reports. 
Navigate to D:\BD\FACSCanto\SetupReports to view and print these reports.
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Maintaining User-Specific Optimization Settings

Task Procedure
Additional 
Information

Maintain settings 
for a single user

1 Run setup.

2 Select an application and optimize.

User-optimized setup 
is calculated for the 
selected application 
and panel type.

Maintain settings 
for multiple users

1 Copy the panel type.opt file.

2 Rename it with a unique name (for 
example, 4 color 
TBNK_username.opt), and save it in 
your choice of location. 

3 To use your optimized results, exit 
the software, rename the file with its 
original file name (for example, 4 
color TBNK.opt or 6 color 
TBNK.opt), and move it back into 
the Setup Results folder.

4 When prompted, overwrite the 
current file.

5 Restart the software, and run setup.

The file is in 
C:\ProgramData\BD\
Shared\Setup 
Results.

Restore 
BD Biosciences 
default settings

1 While the software is not running, 
delete the panel type.opt file.

2 Restart the software, and run setup.

The software 
automatically 
rebuilds the panel 
type.opt file with 
BD-defined settings.
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Using Cytometer Controls

You can adjust cytometer controls only during optimization (immediately after 
setup), or after pausing sample acquisition during a worklist run. Cytometer 
controls are disabled when a worklist is running.

There are three types of cytometer controls: Detectors, Thresholds, and Spectral 
Overlap. Click a tab to access the corresponding controls, or select an option 
from the View menu.

Adjusting Detectors

Adjust the signal for events displayed in plots by changing detector voltages. 
Higher voltages amplify the signal. Lower voltages decrease the signal. 
BD FACSCanto clinical software automatically recalculates spectral overlap 
when you change detector voltages.

To change a setting, click in the field containing the value you want to change. Up 
and down arrows and a plus sign (+) appear. Change the value using one of the 
following methods:

• Select the value and type in a new one.

• Click the up and down arrows.

Tabs

Tabs

After setup, in Wizard During acquisition
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• Click the plus sign (+), and drag the pointer to a new setting.

• Press Ctrl+↑/↓ to adjust settings in minor increments, or Ctrl+Page Up/Page 
Down to adjust settings in larger increments.

Adjusting Thresholds

A threshold sets a channel number below which events will not be processed. Use 
thresholds to filter out unwanted events. You can set one or more thresholds at a 
time, and select whether any one (OR) or all (AND) need to be met. 

To set a threshold:

1 Enable a parameter as a threshold by selecting the checkbox beside it. 

2 Click in the associated Value field to set the threshold value.

Use one of the editing methods specified in Adjusting Detectors on page 76.

Pointer
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Figure 6-1  Adjusting Threshold

3 (Optional) Enable and set another threshold parameter.

a Select the associated checkbox.

b Edit the threshold value.

c Select OR (any of the parameter thresholds can be met) or AND (all of 
the parameter thresholds must be met).

Adjusting Spectral Overlap

Fluorochromes emit light over a range of wavelengths. During cytometer setup, 
fluorescence spillover is automatically determined and corrected. If necessary, 
you can use the spectral overlap controls to make manual adjustments.

1 Click in the Spillover % value field that needs correction (Figure 6-2 on 
page 79). 

2 Use one of the editing methods specified in Adjusting Detectors on page 76.

Pointer
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Figure 6-2  Adjusting Spectral Overlap

Reviewing Levey-Jennings Reports

The software automatically creates a Levey-Jennings Report from the cytometer 
setup data. To view the report:

1 From the main window, click the Levey-Jennings tab.

An exclamation mark on the tab indicates an out-of-range value on the 
report. 

2 Check the plots in the report.
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Parameters outside the limits set by the lab manager are shown with a red x 
in the affected plot. 

3 To add comments to the report, click Comments.

Enter text into the Comments field (up to 2,500 characters), and click OK.

To print the report, click the Print button.
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Running an Acquisition Worklist

An acquisition worklist allows you to run a group of samples, optimize 
cytometer settings and save the data, and obtain automated analysis.

When you first open BD FACSCanto clinical software, a blank worklist appears.
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Entering Information into a Worklist

A worklist can contain information for up to 200 samples.

1 (Optional) Enter a name.

2 Enter an ID. 

To automatically enter sample IDs, use the optional barcode reader.

3 (Optional) Enter a case number.

4 Select a panel.

• Either click in the Panel field, click the down arrow, and select a panel, 
or

• Press Alt+ the down arrow to access the Panel menu, and use the arrow 
keys to select a panel.

* * * ** Software assigned, not user editable

Panel uses BD Trucount tubes

Panel does not use BD Trucount tubes
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If you select a 4-color or a 6-color TBNK panel that does not use 
BD Trucount tubes, to calculate absolute counts you need to either 

• Enter the WBC count (x 1,000) and the lymphs (%), or

• Enter the absolute lymphocyte count (x 1,000)

where .

If you try to enter all three values, the software will alert you with a dialog.

5 (Loader only) Select a carousel ID in the Carousel field. 

Click the down arrow in the field, and select a number. The number you 
select must match the number on top of the carousel.

Running a Process Control

We recommend that you always run a process control using your optimized 
settings before running test samples (unknowns). Process control results are 
automatically exported to a spreadsheet file in C:\ProgramData\BD\FACSCanto 
\DataFiles. If the file already exists, results are appended. Use the file to track 
results over time.

1 In the Name field, enter Control.

2 In the ID field, enter the control’s lot ID.

3 (Optional) Enter a case number and a short comment in this field.

Names other than Control (not case sensitive) will not be exported into the 
control-specific file.

counts cells/μL
1000

------------------=
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4 Select a panel.

5 Run the control as you would a typical sample.

Acquiring Samples

1 Enter all sample information into a worklist.

2 (Loader) Prepare to acquire with the Loader.

a Print the worklist. Load tubes into the carousel(s) according to the 
printout

b Set up the cytometer for automatic loading (page 134).

c Insert the carousel into the Loader, and close the Loader doors.

NOTE Ensure that the carousel is inserted all the way in. If it is not, the 
tube can become jammed in place. Open and close the door twice to release 
the jam.

3 Verify that the cytometer is ready.

Check the status bar at the bottom of the main window, and the Status 
window. If an error condition exists, resolve it before starting the 
acquisition.

4 From the View menu, select to display Detectors, Spectral Overlap, and 
Threshold.

For accurate results when loading, match tube positions to those listed 
on the printout. Make sure to use the carousel rack with the appropriate 
Carousel number. 
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5 Click the Run button.

A dialog appears asking if you want to save the worklist.

6 Click Yes. Specify a file name and storage location in the next dialog.

(Loader) The carousel briefly mixes the samples, and acquisition begins.

7 (Manual) Click Ignore to load tubes manually.

8 (Manual) When prompted, install the tube containing the first worklist 
sample.

a Push the aspirator arm to the left.

b Place the tube on the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

c Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins.

d Click OK.

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.
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Observing and Recording Event Data

The Acquisition tab comes into view and events appear once data has been 
acquired for the first tube. See Figure 6-3.

Figure 6-3  Acquisition tab

1 Observe event data.

Data recording begins as soon as the flow stabilizes. Recording stops 
automatically after the designated acquisition targets have been met.
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After you click the Run button and before data recording begins, you can 
select from the following options.

2 View the Lab Report for recorded data.

If the Lab Report countdown is set to On, the Lab Report is shown for the 
designated time. You can pause and edit the report during the countdown. 
See Inspecting Lab Reports on page 90 for instructions.

Acquiring and Recording the Remaining Samples

Loader acquisition of the next tube starts automatically.

The Status and FCS File fields update as each sample is recorded.

1 (Manual) After data has been recorded for the first tube, remove the tube at 
the prompt and install the next tube.

NOTE To prevent backflow into the tube, follow the tube removal 
sequence exactly. For more information, see Cytometer Troubleshooting on 
page 183. 

Table 6-1  Options before recording

Option Procedure Additional Information

Optimize detectors, 
thresholds, or spectral 
overlap

1 Click the Pause button.

2 Click the Optimize button. 

See page 89.

Change plot 
parameters

1 Right-click an axis label.

2 Select a different parameter.

Proceed with 
recording

Do nothing.

Stop recording data 
for the worklist

1 Click the Pause button.

2 Click the Stop button.

If recording was in 
progress, data for the 
current tube is 
discarded and no FCS 
file is saved.
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a Hold your sample tube while you push the aspirator arm to the left.

b Remove the tube from the SIT.

c Release the aspirator arm.

NOTE If you do not move the aspirator arm to the left and/or unload a 
tube when prompted, an error message appears. If this happens, click OK. 
Push the arm to the left and/or unload the tube. Wait for the Load Tube 
message before you install the next tube.

SIT flush occurs when the aspirator arm comes to center. When cleaning is 
finished, you are prompted to load the next tube.

2 (Manual) Repeat the sequence starting with step 7 on page 85 until there 
are no more samples.

3 (Loader) Load the next carousel when prompted, and click OK.

4 After all samples have been run, review the worklist.

5 After the last run of the day, shut down the system.

See Chapter 9 for instructions.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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Options During Acquisition

Do any of the following during acquisition:

• Adjust voltages, thresholds, and spectral overlap values (page 89)

• Inspect recorded data on the Lab Report (page 90)

• Skip tubes or samples (page 94)

• Stop recording and acquisition (page 94)

• Add samples to a worklist (page 95)

Optimizing During a Run

For instructions on using optimization controls, see Using Cytometer Controls on 
page 76.

1 At the Acquisition view, click the Pause button on the toolbar to pause.

2 Click the Optimize button.

Live events are displayed without being recorded.

3 Use Detectors controls to adjust detector voltages.

4 Use Thresholds controls to adjust the threshold.

5 Use Spectral Overlap controls to adjust compensation settings. 

6 Click the Run button to return to data recording.

7 Decide how to apply the optimized changes and click the corresponding 
button.
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The software applies the updated settings and finishes running the tube 
(unless you click Cancel or Revert to Original).

Inspecting Lab Reports

To inspect a Lab Report during acquisition, set the Lab Report display 
countdown.

Specifying a Display Time for the Lab Report Countdown 

1 Select Tools > Options.

2 Click the Lab Report button.

3 Select On, time to display countdown (sec).

4 Enter a number of seconds, from 1 to 10, and click OK.

The software overwrites all events recorded prior to optimizing for the 
current tube.
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If the Lab Report countdown is set, recorded data displays in the Lab Report 
view. A message shows the time remaining to view the report. 

During the countdown, you can pause the run and do any of the following:

• Re-Gating a Plot Manually

• Reapplying the Auto-Gate on page 92

• Re-Running a Tube on page 93

• Verifying Report Review on page 93

Re-Gating a Plot Manually

You can wait until the entire worklist has completed to review plots on the Lab 
Report. However, if you prefer to re-gate plots during a worklist run, follow 
these steps.

1 In the Lab Report Countdown dialog, click Pause.

2 Click any plot to adjust its gate.
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The selected plot appears in an enlarged view.

3 Adjust the gate.

a Select the gate by clicking its boundary.

b Drag the selection handle to adjust the shape or size of the gate.

c Drag the gate boundary between selection handles to move the gate.

Gate changes apply only to the current tube.

4 Click OK.

Reapplying the Auto-Gate

To override gate changes and return to the automatic gate, click Auto-Gate.

When the confirmation message appears, click Yes.

Selection handle
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Re-Running a Tube

After you inspect the data on the Lab Report, you can elect to re-run the tube. 
Re-running a tube overwrites the previous data for it.

1 Click Re-Run at the top of the Lab Report view.

2 Select the tubes you want to re-run, and click OK.

You can re-run all tubes or a single tube of the current sample.

Verifying Report Review

You can append a virtual signature to reviewed reports.

1 Click Review at the top of the Lab Report view.

2 Select a reviewer, and click OK.

• Select Current User for the current, logged-in user.

• Select Other User for a different user. Select the User ID from the menu, 
and enter a password.

The corresponding worklist Status field changes to Reviewed.
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Skipping a Tube

1 Under the Acquisition tab, click the Pause button.

2 Click the Skip button.

3 Select whether you want to skip to the Next Tube or Next Sample.

Skipped tubes are indicated on the worklist.

Stopping Recording

To stop recording data for the current sample, click the End Recording button 
under the Acquisition tab.

The software saves the data already recorded for that tube and proceeds to the 
Lab Report view or starts acquisition of the next sample.
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Adding Samples to the Worklist

You can stop worklist acquisition and add samples to the worklist.

1 Click the Pause button, followed by the Stop button to stop the acquisition.

2 If a sample tube was loaded manually, remove the tube from the SIT.

3 Enter new sample information into the worklist.

4 Click the Run button to resume.

Reviewing an Analysis Worklist

An analysis worklist allows you to reanalyze FCS files previously created by 
BD FACSCanto clinical software. Only FCS files created in BD FACSCanto 
clinical software can be processed in an analysis worklist. Do not modify 
BD FACSCanto FCS files with other software applications.

Every time you reanalyze an FCS file, only the latest analysis is saved. 

Creating a New Analysis Worklist

1 Select File > New Analysis Worklist.

2 Add FCS files. 

By default, the software stores FCS files in a dated folder in 
D:\BDFACSCantoFCSFiles.

• To add selected files, click the Add Files button, navigate to the folder 
containing the files, and select them. Click Open.

FCS files created with BD FACSCanto clinical software version 2.4 or later 
cannot be used with an earlier version of BD FACSCanto clinical software 
software. Earlier versions will show incorrect results.
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0

Only the FCS file for the first tube in a panel is displayed. All tubes in 
the panel are automatically imported when you select this file.

• To add all files in a folder (including files in subfolders), click the Add 
Folder button, locate and select the folder, and click OK.

3 Verify that the worklist contains all required files.

4 Continue to add FCS files (up to 200).

Opening an Existing Analysis Worklist

1 Select File > Open Worklist.

2 Navigate to the folder containing your saved worklists.

By default, worklists are stored in D:\BD\FACSCanto\Worklists.

3 From the Files of Type menu at the bottom of the window, select Analysis 
Worklists (*.wka).

4 Select an analysis worklist, and click Open.
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Reviewing a Lab Report

After all samples in a worklist have been processed, inspect the Lab Report for 
each sample. You can review Lab Reports after each sample is run, or after an 
acquisition worklist is complete. The following table describes Status entries.

To review a Lab Report, do the following.

1 Double-click the Status field for the sample that needs review.

Status Meaning

Ready To 
Run

All columns filled in and sample ready for acquisition

Not Prepped Sample skipped—prep on SPA II or SPA III unsuccessful

Running Sample currently being acquired

OK Sample successfully acquired and analyzed with no QC messages

Partial A tube belonging to the sample was successfully acquired or analyzed, 
while another tube was skipped

Incomplete Not all tubes in a multitube panel were recorded

Skipped All tubes belonging to the sample were skipped or aborted by the user

Needs 
Review

Results out of alarm range, or a QC message appears on the Lab 
Report

Reviewed Sample marked as reviewed
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The Lab Report for that sample appears.

Figure 6-4  Lab Report

• You can adjust gates, revert to auto-gates, or append a virtual 
signature, ie Review, to the report.

• For suggestions on addressing QC messages, see page 210.

2 Continue reviewing reports as needed.

Use  to navigate to other Lab Reports in the worklist.

3 Save the worklist.

Saving a worklist allows you to reanalyze data and review Lab Reports at a 
later time and use the worklist as a template.
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Running Cleaning Tubes

1 Create a worklist.

a Enter Clean as the Sample ID.

b Select a two-tube panel (such as 4 color TBNK) from the panel field 
menu.

2 Click the Run button.

3 When prompted to save the worklist, click No.

4 (Loader Only) Click Ignore to run tubes manually.

5 When prompted, install a tube with ≤3 mL of BD FACS cleaning solution 
or 10% bleach on the SIT. Firmly push up on the tube until it comes to a 
complete stop and is fully seated.

6 Click OK.

7 After 5 minutes, click the End Recording button.

Do not click Pause.

8 When prompted, unload the tube.

9 Install a tube with ≤3 mL of DI water. Firmly push up on the tube until it 
comes to a complete stop and is fully seated.

10 Repeat steps 6 through 8.

Each panel has default acquisition targets. A lab manager should set the 
time target (Max time for acquisition) for the two-tube panel to be used for 
the Clean to no less than 300 seconds (5 minutes).
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Logging Out

To stop using the software without shutting down the flow cytometer, click the 
Logout button to log out. 

The next user can now log in.
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7

Running Samples with
BD FACSDiva Software

This chapter provides the following information on how to use BD FACSDiva 
software features to record and analyze sample data: 

• Optimizing with BD FACSDiva Software on page 102

• Sample Reagents on page 112

• Setting Up the Global Worksheet on page 113

• Setting SPA User Preferences on page 114

• Recording Data on page 118

• Analyzing Data on page 120

• Running Cleaning Tubes on page 124

• Logging Out on page 125
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Optimizing with BD FACSDiva Software

To optimize cytometer settings in BD FACSDiva software:

1 Exit BD FACSCanto clinical software, if necessary.

a Select File > Exit.

b Select Exit only in the dialog, and click OK.

2 Start BD FACSDiva software, enter your user name and password, and 
click OK.

Verifying Cytometer Configuration and User 
Preferences

1 Select Cytometer > View Configurations and verify the current parameters.

If changes are necessary, contact your Lab Manager.

2 Verify that the filters are appropriate to run FITC, PE, PerCP-Cy5.5, 
PE-Cy7, APC, and APC-Cy7 fluorochromes.

3 Exit CS&T, then select Edit > User Preferences and clear all options in the 
General tab.

Do not change the cytometer configuration without consulting 
BD Biosciences. Doing so can invalidate results.

For accurate data results, the octagon and trigon arrays must match the 
current Cytometer Configuration.
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Figure 7-1  User Preferences General tab

4 Click OK to save the changes.

Creating the Experiment

1 Click the corresponding buttons on the Workspace toolbar to display the 
Browser, Cytometer, Inspector, Worksheet, Acquisition Dashboard, and 
Biexponential Editor windows as needed.

2 (Optional) Create a folder:

a Select your database icon in the Browser, and click the New Folder 
button on the Browser toolbar. 

b Rename the folder.

3 Select the folder and click the New Experiment button to create a new 
experiment.

Database icon
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An open experiment appears.

4 Rename the experiment.

5 Select the experiment-level cytometer settings, and click the Parameters tab 
in the Inspector.

6 Change, add, or delete parameters as needed.

• To change, select a parameter, and select a new one from the menu.

• To add, click Add. A new line appears. Select it, and select a parameter 
from the menu. 

The Add button is enabled only when fewer than the maximum 
number of parameters are shown in the Inspector.

• To delete, click the selection button next to the parameter and click 
Delete.
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7 In the Acquisition Dashboard, verify that the SIT Flush checkbox is 
selected.

Applying the Setup Results

1 Right-click the experiment-level cytometer settings, and select Link Setup.

2 Select the setup that you want to link from the Compensation Setup dialog.

BD FACSCanto clinical software generated a Lyse/No-Wash and a Lyse/
Wash setup.

NOTE Entries in bolded text are setups created in BD FACSDiva software.

3 Click Link.

We recommend leaving the SIT Flush option enabled to minimize carryover 
between tubes.
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Creating Compensation Controls

1 Unlink the Compensation Setup if it has been previously linked.

2 Select Experiment > Compensation Setup > Create Compensation 
Controls.

3 (Optional) Edit the labels associated with parameters.

Edit labels when your experiment contains samples stained with the same 
fluorophore conjugated to different antibodies (labels) that require 
different compensation values. Compensation differences are especially 
noticeable in tandem conjugates, due to lot-to-lot variation.

4 Click OK.

The software adds a compensation control, containing stained control 
tubes and one unstained control tube, to your experiment. Normal 
worksheets containing the appropriate plots are added for each 
compensation tube.
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Optimizing Cytometer Settings

When you performed cytometer QC, voltage settings were adjusted to set each 
parameter at a target value. These settings might not be appropriate for the 
stained sample(s) you plan to analyze. Before recording data, adjust FSC, SSC, 
and threshold settings; gate on the population of interest (such as lymphocytes); 
and adjust voltages to optimize fluorescence signal.

For these adjustments, you will need an unstained control sample. It is important 
to perform these steps in order, since some adjustments influence others.

Running the Unstained Control

1 Install the unstained control tube on the cytometer.

a Push the aspirator arm to the left.

b Place the tube onto the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

c Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins.

2 Verify that the green current tube pointer is set to the unstained control 
tube in the Browser. Click Acquire Data.

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.
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3 Adjust the FSC and SSC voltages to appropriately display the scatter 
properties of the unstained control.

Figure 7-2  Voltages adjusted 

4 Click the Threshold tab and adjust the FSC Threshold, if needed.

Set the threshold to remove most of the debris without cutting off the 
lymphocyte population (Figure 7-2).

5 Adjust the P1 gate on the Unstained Control worksheet to surround only 
the lymphocyte population (Figure 7-2).

Select the gate by clicking on the boundary. Once you select the gate, you 
can drag to move it, or drag any of the selection handles to change the gate 
shape and size.

6 Once the gate is adjusted, right-click its boundary and select Apply to All 
Compensation Controls.

This applies your gate changes to the P1 gates on the remaining 
compensation worksheets.

7 Optimize the voltages by making sure that the negative populations for 
each fluorescence parameter are on scale, using the fluorescence histograms 
on the Unstained Control worksheet.

8 Click Stop Acquiring to stop acquisition.

9 When acquisition stops, remove the unstained control tube.
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a Hold the sample tube while pushing the aspirator arm to the left.

b Remove the tube from the SIT.

c Release the aspirator arm.

SIT cleaning occurs when the aspirator arm comes to center.

d Wait for the Progress dialog to close before loading the next tube onto 
the SIT.

NOTE To prevent backflow into the tube, follow the tube removal 
sequence exactly. For more information, see Cytometer Troubleshooting on 
page 183.

Running the Stained Sample and Recording Data

1 Install the stained sample tube on the cytometer and click Acquire Data.

a Push the aspirator arm to the left.

b Place the tube onto the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

c Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins, but not touch them. A correctly seated tube will be above 
the aspirator.

2 If necessary, decrease the voltages to place the positive population for each 
fluorescent parameter on scale.

3 Click Stop Acquiring to stop acquisition.

4 Remove the stained sample tube.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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5 Re-install the unstained sample tube and click Acquire Data.

6 Wait 3 to 5 seconds, then click Record Data to record data for the 
unstained control tube.

7 When acquisition stops, remove the tube.

Calculating Compensation

For these adjustments, you will need a single-stained control sample for each 
parameter to be measured.

1 Install the first stained control tube onto the cytometer.

2 In the Acquisition Dashboard, click Next Tube.

3 Click Acquire Data.

4 Verify that the P1 gate encircles the population of interest, and click 
Record.

5 When recording is finished, remove the tube.

NOTE To prevent backflow into the tube, follow the tube removal 
sequence exactly. For more information, see Cytometer Troubleshooting on 
page 183. 

a Hold your sample tube while you push the aspirator arm to the left.

b Remove the tube from the SIT.

Do not change the PMT voltages after the first compensation tube has been 
recorded. To calculate compensation, all tubes must be recorded with the 
same PMT voltage settings. If you need to adjust the PMT voltage for a 
subsequent compensation tube, delete the current compensation specimen, 
recreate the specimen, and run all the compensation tubes again.
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c Release the aspirator arm.

6 Install the next tube onto the SIT.

7 Repeat steps 2 through 6 until data for all stained control tubes has been 
recorded.

Adjusting Gates

1 Make sure the current tube pointer is set to the first stained control (FITC 
Stained Control) tube.

2 Double-click the FITC Stained Control tube in the Browser to locate the 
corresponding plots on the normal worksheet.

3 If needed, move the P2 gate to encompass the fluorescence-positive 
population.

Figure 7-3  Gating the positive population

4 Make sure the current tube pointer is set to the next stained control tube; 
double-click the tube in the Browser to locate the corresponding plots on 
the normal worksheet.

5 Repeat steps 3 and 4 for the remaining compensation tubes.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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Creating a Compensation Matrix

1 Select Experiment > Compensation Setup > Calculate Compensation.

If the calculation is successful, a dialog appears prompting you for the 
name of the compensation setup.

2 Enter a name for the compensation setup, and select either Link and Save 
to link the setup to the experiment’s cytometer settings, or Apply Only. 
Click OK.

NOTE We recommend that you confirm the compensation setup by 
running a process control before you run samples.

Sample Reagents

For the following experiment, data will be recorded and analyzed for two tubes 
of human peripheral blood stained with the following reagents: 

• CD3 FITC

• CD16+CD56 PE

• CD45 PerCP-Cy5.5

• CD4 PE-Cy7

• CD19 APC

• CD8 APC-Cy7

For other analysis methods, see the information supplied with the reagent.
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Setting Up the Global Worksheet

This section shows you how to use a global worksheet to preview and record 
data for multiple samples.

1 Open the experiment in which you optimized cytometer settings.

2 Create a new specimen by clicking the New Specimen button. Rename it 
LWB.

3 Create two tubes under the LWB specimen, and rename them, for example, 
TBNK_001 and TBNK_002.

To create a second tube, select the specimen, and click the New Tube 
button.

4 Create a global worksheet.

• If the Default global worksheet preference is enabled in User 
Preferences (default option), the global worksheet is already present. 
Expand the Global Worksheets folder to locate and rename the 
worksheet.

• If the Default global worksheet preference is disabled, create a global 
worksheet by clicking the New Global Worksheet button in the 
Browser toolbar.

5 Rename the global worksheet Record Data.

6 Use the Experiment Layout to define parameter labels and to specify the 
number of events to record for each tube. Labels will appear on the plot 
axes and in all statistics views.

a Select Experiment > Experiment Layout.

b Under the Labels tab, enter appropriate labels for the tube. For 
example, enter CD3 in the FITC field. Use the Tab key to move to the 
next field (Figure 7-4).
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Figure 7-4  Entering parameter labels

c Under the Acquisition tab, verify 10,000 events to record for tubes 
TBNK_001 and TBNK_002. Click OK.

7 On the global worksheet, create plots for previewing the data.

For example, create PerCP-Cy5.5 vs SSC, FITC vs APC, FITC vs PE, 
FITC vs PE-Cy7, and FITC vs APC-Cy7 dot plots.

Setting SPA User Preferences

Importing a Worklist from the SPA Software

You can import sample information from a worklist created in BD FACS™ 
Sample Prep Assistant (SPA) software. When you import a SPA worklist, the 
XML file contains defined keywords and elements used to populate an 
experiment. All of the keywords and elements are associated with the samples in 
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the imported SPA worklist (XML) file. In addition, the order of the keywords and 
elements within the experiment layout matches the order found in the worklist.

To import a SPA worklist:

1 (Optional) In Sample Prep Assistant software, print a report of the worklist 
you want to import into BD FACSDiva software.

2 Verify that tube and panel names from the SPA worklist exactly match 
those in the BD FACSDiva panel template.

3 If there is a discrepancy, create a new panel template in BD FACSDiva 
software to match the reagent panel in the SPA software.

4 Select File > Import > Worklist.

5 Navigate to and select a worklist, and click Import.

NOTE If you need to edit and delete keywords and elements belonging to 
the imported worklist, open the worklist before importing and review the 
current information. Edit missing or incorrect entries, as needed, and save.

BD FACSDiva software creates a locked experiment that includes all 
specimens prepared in the SPA worklist.

6 Following the import, select a specimen and open the Inspector window to 
review the imported information.

Editing an Imported SPA Worklist

The Edit > User Preferences - General tab option, Allow editing of imported SPA 
worklists, is enabled by default.

You can edit and delete some of the keywords and elements belonging to the 
imported worklist. 

To import the worklist, all reagent and panel names must exactly match 
those used in BD FACSDiva software. 
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1 Select a specimen.

2 Open the Inspector window.

3 Click the Keywords tab.

Keywords that are associated with the SPA worklist are shown, based on 
the imported XML file.

NOTE The following keywords cannot be edited or deleted: SAMPLE 
NAME, SAMPLE ID, CASE NUMBER, PANEL NAME, PATIENT ID.

4 Select an item, change the information as necessary, and click Edit.

Applying Panel Analysis to SPA Worklists on Import

A panel is a collection of tests, reagents, or markers commonly used together in 
the same experiment. A panel template is used to analyze the experiment data. 
The panel template applies changes to the normal worksheet elements of a 
selected specimen. When you import a SPA worklist, you have the option to 
manually or automatically apply a panel template to specimens in an experiment.
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The Apply panel analysis to SPA worklists on import option is enabled by 
default. A panel template is automatically applied to the experiment. When this 
option is cleared and you import a SPA worklist, the Panel Templates dialog 
appears for you to select a panel to import.

1 Select Edit > User Preferences - General tab.

2 Confirm that Apply panel analysis to SPA worklists on import is selected.

3 Click the Templates tab.

4 Click the Templates button for the specimen.

The Panel Templates dialog opens.
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5 Select a panel to import and use as the default template, and click OK.

The changes are saved with your login name and are retained from one 
session to the next.

Recording Data

If you want to save a copy of the data displayed in the global worksheet with 
each recorded tube, enable the Save analysis after recording through global 
worksheet preference in the User Preferences window (Figure 7-1 on page 103). 
If you do not want to save a copy of the data, leave the preference disabled.

1 Install the first sample tube onto the cytometer.

a Push the aspirator arm to the left.

b Place the tube on the SIT, ensure the tube is straight, and firmly push 
up until the tube comes to a complete stop and is fully seated.

c Center the aspirator arm under the tube. There are three sensor pins on 
the aspirator arm. The bottom of the tube should sit within the center 
of the pins, but not touch them. A correctly seated tube will be above 
the aspirator.

2 In Acquisition Setup, verify that you are using an appropriate flow rate and 
that the SIT Flush checkbox is selected.

Always wear gloves when manually loading samples. A fluid flush of the 
exterior of the sample injection tube (SIT) occurs between samples that 
might contain biohazardous waste.
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• Hide or show acquisition setup information by right-clicking the 
Dashboard anywhere outside the Basic Controls area and selecting the 
option from the menu.

• Low = approximately 10 µL/min of sample

• Medium = approximately 60 µL/min of sample

• High = approximately 120 µL/min of sample

3 Move the current tube pointer to the first tube. Click Acquire Data.

4 While data is being acquired, draw a gate around the lymphocytes. Set the 
other plots to show data from the lymphocyte population.

5 Click Record Data.

6 When all events have been recorded, unload the sample tube when the 
aspirator arm lowers.

a When the aspirator arm lowers, hold your sample tube while you push 
the aspirator arm to the left.

We recommend leaving the SIT Flush option enabled to minimize carryover 
between tubes.
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b Remove the tube from the SIT.

c Release the aspirator arm.

NOTE If the tube is not removed within approximately 30 seconds, the 
aspirator arm will lock against the tube. You will be prompted to either 
continue acquiring or remove the tube.

7 When the SIT flush is complete, load the next tube.

8 Click Next Tube, and then Acquire Data.

9 Preview the data in the global worksheet. Click Record Data.

10 Repeat steps 6 through 9 until data has been recorded for all tubes.

(Optional) To print the experiment-level cytometer settings or the 
Cytometer Status report, right-click the cytometer settings icon and select 
Print.

Analyzing Data

1 Create a new global worksheet. Rename it TBNK Analysis.

2 Select the first tube under the LWB specimen and create the following dot 
plots: PerCP-Cy5.5 vs SSC, FITC vs APC, FITC vs PE, FITC vs PE-Cy7, 
and FITC vs APC-Cy7.

3 Resize the plots so they fit on one page.

By default, the plots will fit on one page if you select three across.

4 On the PerCP-Cy5.5 vs SSC plot, draw a gate around the lymphocytes. Use 
the population hierarchy to rename the population Lymphocytes.

If you move the arm without holding the tube, the tube could fall off the 
SIT and expose you to potentially biohazardous sample.
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5 Select all plots except the PerCP-Cy5.5 vs SSC plot and specify to show 
only the Lymphocyte population.

Hold down the Control key while you select successive plots. Once all plots 
are selected, select the checkbox next to Lymphocytes in the Plot Inspector. 

6 Select all plots and click the Title tab in the Plot Inspector. Select the 
checkboxes to display the tube and specimen names in the plot titles.

7 Create a statistics view. Edit the view to show the Lymphocyte population 
and subpopulations, and to display the mean for all fluorochromes.

To create a statistics view, right-click any plot and select Create Statistics 
View. The resulting statistics view lists the number of events, %Parent, and 
means of the plot parameters for all populations displayed in the plot.

8 Draw a gate around the CD19 positive population on the CD3 FITC vs 
CD19 APC plot. Name the population B Cells.

9 Draw a gate around the CD16+56 positive population on the CD3 FITC vs 
CD16+56 PE plot. Name the population NK Cells.

10 Draw a gate around the double-positive population on the CD3 FITC vs 
CD4 PE-Cy7 plot. Name the population T Helper.

11 Draw a gate around the double-positive population on the CD3 FITC vs 
CD8 APC-Cy7 plot. Name the population T Cytotoxic.

12 Print the analysis.
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Figure 7-5  Lymphocyte analysis (example)

CD8 APC-CCD4 PE-Cy7CD16+56 PE CD45 PerCP-Cy5.5CD3 FITCSSC-AFSC-H CD19 APC
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Reusing the Analysis

Now that the analysis strategy has been defined, use it to analyze the remaining 
tubes in the experiment. Global worksheets allow you to apply an analysis 
strategy to a series of data files without saving the analysis each time. After 
previewing the data, you can print the analysis or save it to a tube-specific 
(normal) worksheet.

1 Move the current tube pointer to the next tube under the LWB specimen.

2 View the data on the global worksheet. Make adjustments to gates, as 
needed.

Adjustments will also apply to the next tube viewed on the global 
worksheet. If you don’t want to alter the global worksheet, save the 
analysis as described in the next section and make adjustments on the 
tube’s normal worksheet.

Saving the Analysis

Since the analysis objects were created on a global worksheet, the analysis will 
not be saved with each tube. If you want to save a copy of the analysis with any 
tube, do the following.

1 Expand the TBNK Analysis global worksheet in the Browser.

2 On the Worksheet toolbar, click the Global Worksheets button to switch to 
the normal worksheet view.

3 Create a new normal worksheet for the destination tube. Rename the 
worksheet.

4 In the Browser, right-click the analysis object below the global worksheet 
icon and select Copy.
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5 Select the tube in the Browser. Right-click the tube icon and select Paste.

The elements on the global worksheet are copied to the new normal 
worksheet. View the analysis by double-clicking the tube in the Browser.

NOTE Automatically save a copy of the analysis with each tube by 
enabling the Save Analysis After Recording preference before you record 
data. In this case, the analysis plots are placed on the normal worksheet 
that is open at the time of recording. To control where the plots are placed, 
create a new normal (tube-specific) worksheet before data is recorded.

Running Cleaning Tubes

Use this procedure when cleaning the cytometer manually (without the Loader). 

NOTE When the Loader is installed, use the alternate procedure for Running 
Cleaning Tubes on the Loader on page 143. 

Install a tube with ≤3 mL of BD FACS cleaning solution or 10% bleach on the 
SIT. Firmly push up on the tube until it comes to a complete stop.

1 Under Basic Controls, click Acquire Data.

2 Watch the time in the Elapsed Time field.
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3 After 300 seconds (5 minutes), click Stop Acquiring and remove the tube.

4 Install a tube with ≤3 mL of DI water on the SIT. Firmly push up on the 
tube until it comes to a complete stop and is fully seated.

5 Repeat steps 1 and 3.

Logging Out

Log out when you are finished using BD FACSDiva software, but are not ready 
to shut down the system.

1 Select File > Log Out.

2 If the system will be used to run samples after you log out, select Log out 
only.

NOTE If you select Log out after a fluidics shutdown, keep in mind that 
fluidics shutdown can take up to 5 minutes to complete.

The BD FACSDiva workspace is hidden and the Log In dialog appears. The 
system is available for the next operator to log in.
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8

Using the Loader with
BD FACSDiva Software

This chapter provides the following information about using the BD FACS 
Loader with BD FACSDiva software:

• Getting Ready on page 128

• Assigning Carousels and Verifying Run Settings on page 130

• Preparing the Loader on page 134

• Running Samples on page 136

• Running Cleaning Tubes on the Loader on page 143
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Getting Ready

1 Start up the cytometer, workstation, and software.

2 Perform cytometer quality control and sample optimization.

3 (Optional) Open a new experiment, and copy your optimized cytometer 
settings from step 2 to the new experiment.

Alternatively, you can work with the experiment used during sample 
optimization and add new specimens to that.

NOTE You must use a global worksheet for data display when acquiring 
samples with the Loader.

4 Add specimens and tubes to your experiment (see Figure 8-1 on page 129).

To add a predefined panel:

a Select any Browser item within the open experiment, and select 
Experiment > New Specimen. 

b Click the BD Panels tab and select a panel.

c Specify the number of copies (each copy creates a new specimen in the 
Browser), and click OK.
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Figure 8-1  Panel Templates dialog

5 If you imported panels, inspect the information and the cytometer settings 
for each panel type to make sure they are complete and appropriate.
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Assigning Carousels and Verifying Run Settings

1 Select Edit > User Preferences.

2 Click the Carousel tab, then click the General tab.

3 Make selections for printing and pausing.
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4 Select how you want the Loader to handle any tube pressurization errors 
that occur during the run.

NOTE To make changes to the Tube Pressurization Error Handling options 
for the current run only, use the Carousel Setup window. See Figure 8-2 on 
page 132.

5 Click the Carousel tab and then click the Save Options tab, and specify 
whether and where to automatically save the statistics results and Carousel 
Report.

6 Click OK to save changes.

7 Select Carousel > Carousel Setup.

Tube Pressurization 
Error Handling Options

Function

Show error and wait Stops the run and waits for you to select 
whether to abort the run, skip the tube, or skip 
to the next specimen

Skip to next tube Automatically moves to the next tube if an error 
is encountered

Skip to next specimen Automatically moves to the next specimen if an 
error is encountered 
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All specimens or panels in the experiment are listed at the top of the 
Carousel Setup window, in a worklist format. Carousel locations are 
automatically assigned.

NOTE Specimens to be run using the carousel must have 40 tubes or fewer.

Figure 8-2  Carousel Setup window

8 (Optional) Specify a folder to export the FCS data from a carousel run.

Click the folder in the Export Folder column and select a directory. 
D:\BDExport\FCS is the default folder.

9 (Optional) Insert or delete carousel breaks.
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Carousel breaks, represented by a thick horizontal line, indicate the start of 
a new carousel. The software automatically inserts them whenever a 
carousel cannot contain the next specimen’s tubes. To change carousel 
assignments for tubes, insert and delete breaks.

You can insert or delete breaks only on an unassigned carousel (the 
carousel ID is None).

• To insert, select a row, click New Carousel, and select an ID number 
from the list.

• To delete, select None from the Carousel ID list, select the break line, 
and click Delete Carousel Break.

10 Click in the Carousel ID field for each specimen and assign a carousel ID 
from the list to each specimen.

11 Click Print to print a record of tube and carousel assignments, as well as 
the FCS directory selected for each specimen. 

Use the printout as a guide when filling the carousels.

12 Verify the Run Settings in the Carousel Setup window.

13 Click OK to save changes.

Run Settings Options Range Function

Recording Delay time 3–15 seconds Allows acquisition to 
stabilize before recording 
begins

Start of carousel mix Performs a 10-second mix 
when the run begins

Interim mix After every 1–20 tubes Performs a mix after a 
specified number of tubes

Mix duration 3–25 seconds Allows you to set the 
duration of the interim mix
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Preparing the Loader

1 Set up the cytometer for automatic loading. 

Figure 8-3  Automatic loading

2 Gently remove the carousel from the cytometer as shown.

Aspirator arm bar horizontal, 
pointing away from carousel

Tube guide forward
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3 Vortex the sample tubes and place them uncapped in the carousel(s) 
according to the worklist.

4 Install the first carousel to be acquired on the Loader.

Position the spindle hole in the handle over the center spindle of the Loader 
drawer. Rotate the carousel until the alignment guide pin fits into the small 
alignment hole at the top of the carousel. Press down firmly to seat the 
carousel.

Figure 8-4  Carousel components

5 Close the Loader drawer completely, and close the Loader doors.

For accurate results, match the tubes to those listed on the printed worklist 
or Carousel Setup (BD FACSDiva software).

To prevent binding during loading, make sure that each tube has a 
maximum of two labels. Flatten labels completely before placing a tube in 
the carousel.

Spindle

Handle

Alignment pin
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The Loader scans and positions the carousel at tube 1.

Running Samples 

Before the Run

If the stopping time is 0, the software uses a default stopping gate based on 
number of events. When you enter a time, the software stops either when it 
reaches the total number of events, or when it reaches the time limit, whichever 
comes first.

NOTE We recommend that you always enter a stopping time. Setting a time limit 
ensures that the carousel doesn’t stall on one tube if that tube should contain a 
dilute sample or rare events.

To run samples:

1 To activate the acquisition controls, move the current tube pointer to the 
first tube in your experiment.

To run the Loader, the doors must be closed. Tubes will not load with the 
doors open. The currently running tube will be unloaded if you open the 
doors during a run.

Loader doors 
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2 In Acquisition Setup (Figure 8-5):

a Verify that you are using an appropriate flow rate.

b Enter a stopping time (seconds).

Figure 8-5  Acquisition Setup in Acquisition Dashboard

3 In Carousel Controls, click Run Carousel.

NOTE If the Carousel Controls are not displayed on the dashboard, 
right-click on the dashboard and select Carousel Controls.

4 View data for the first tube on the global worksheet. 

The ID of the currently running carousel, along with the tube’s position, is 
displayed in Carousel Controls. 

5 If necessary, click Pause and make adjustments to cytometer settings or the 
analysis. 

6 Click Resume to proceed with acquisition of the next tube. 

Current tube pointer
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During the Run

Data for the current tube is displayed in the global worksheet view for the 
amount of time specified in General Carousel preferences. Any changes to the 
global worksheet remain in effect for the rest of the tubes that use the same 
worksheet.

Tube processing continues until the carousel run is complete. Repeat step 4 
through step 6 in the preceding section for the remaining tubes on the carousel.

To run more than one carousel:

1 Remove the carousel.

2 Load the next carousel when prompted. Click Continue.

3 When done, review the Carousel Run Report. Any tube errors that 
occurred during the run are highlighted.
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Figure 8-6  Example Carousel Run Report

After the Run

The report prints automatically if specified under the General tab of the Carousel 
tab under User Preferences. If you selected automatic saving under the Save 
Options tab of the Carousel tab, the report is saved to the designated directory. 
You can also save the report as a PDF or export it.

Skipping or Re-Running Samples

When you re-run a sample, existing data is not overwritten if you have enabled 
one of the following:

• If the Export FCS after recording preference is enabled, a new FCS file is 
saved as: <Specimen Name>_<TubeName>_<DDMMYYYYHHMMSS>.fcs, 
where DDMMYYYY represents the date and HHMMSS represents the time 
the new file was saved. If the exported file is from an experiment created 
from an imported SPA worklist, the keyword PANEL NAME and its value 
are written to the FCS file header.
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• If the Automatic Saving preference is enabled for statistics results, a new 
row is written to the statistics results file. 

Skipping or Re-running Tubes or Specimens During a Run

To skip a tube or specimen:

1 Click Skip in Carousel Controls. 

2 In the dialog that appears, select tube or specimen.

The carousel moves to the next tube or specimen.

To re-run a tube or specimen:

1 Click Rerun in Carousel Controls.

2 In the dialog that appears, select either tube or specimen.

The carousel moves to re-run the selected tube or specimen.

Re-Running Tubes or Specimens After Acquisition

1 Click Run Carousel in Carousel Controls.

2 In the re-run dialog that appears, select the tubes or specimens you want to 
re-run. Click OK to close the dialog.
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NOTE When you re-run a sample, existing data is stored only if the Export 
FCS after recording preference is enabled. 

Adding Tubes to an Existing Carousel

1 In the current experiment, add a specimen.

2 Select Carousel > Carousel Setup.

3 Delete the Carousel break.

The Carousel ID is automatically assigned to the new specimen in the 
worklist.

4 Click Run Carousel in Carousel Controls.

5 In the re-run dialog that opens, select the new tubes or specimen. Click OK 
to close the dialog.
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Re-Running a Carousel

1 After all tubes in the carousel are recorded, click Run Carousel in Carousel 
Controls.

2 In the dialog that appears, select all tubes in the carousel. Click OK to close 
the dialog.

The run begins.

Stopping a Run

To stop a carousel, click Stop Carousel in Carousel Controls. The run stops and 
the Carousel Report appears.

Running a Single Tube

1 To run a single tube using the carousel, click Run Single Tube in Carousel 
Controls.

2 In the dialog that appears, select the tube you want to run. Click OK to 
close the dialog and begin the run.

See Figure 8-7 on page 143.
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Figure 8-7  Single Tube Loader dialog

3 When the tube is finished, click Unload in the Acquisition Dashboard.

Running Cleaning Tubes on the Loader

1 In Acquisition Setup, check that flow rate is set to Medium.

2 Select Carousel > Clean. Select the tube type and number of minutes to run 
each tube.
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3 Click OK.

4 Move the current tube pointer to the first cleaning tube.

5 Place tubes filled with the appropriate solution in the designated positions 
in the cleaning rack.

We recommend using at least BD FACS cleaning solution and DI water.

6 Click OK to begin cleaning.
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Shutting Down

This chapter provides the following information for shutting down your 
application software and instrument:

• About Shutdown on page 146

• Shutting Down BD FACSCanto Clinical Software on page 146

• Shutting Down BD FACSDiva Software on page 146

• Cleaning the Surfaces on page 147
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About Shutdown

• Turn off the cytometer when not in use to preserve laser life.

• At the end of the day, shut down the cytometer after running a fluidics 
shutdown.

• After every 4 hours of operation, and during cytometer shutdown, you will 
hear a hiss as condensed water discharges from the fluidics cart pumps into 
the condensation trap.

Shutting Down BD FACSCanto Clinical Software

1 Select File > Exit, and select Run fluidics shutdown and exit.

2 When fluidics shutdown completes, the software closes.

3 Turn off the cytometer power.

4 Shut down the computer.

Shutting Down BD FACSDiva Software

1 Select Cytometer > Fluidics Shutdown, and then follow all prompts.

2 Turn off the cytometer power.

3 Exit BD FACSDiva software.

4 In the dialog that opens, verify that Exit application only is selected and 
click OK.

To prevent fluid overflow, do not leave a tube on the SIT during fluidics 
shutdown.
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5 Shut down the computer.

Cleaning the Surfaces

Following shutdown:

1 Wet a soft, lint-free cloth with DI water and gently wipe down the 
following surfaces daily to remove salt buildup:

• SIT 

Be careful not to bend the SIT.

• Aspirator arm

Wipe all exposed surfaces of the aspirator arm that are outside the 
cytometer chassis.

2 Use a dry lint-free cloth to remove residual moisture.

3 Place an empty tube on the SIT to catch any BD shutdown solution that 
might drip from the SIT.

4 Empty the condensation trap located underneath the fluidics cart power 
panel. See Figure 1-7 on page 27.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

To prevent damage, do not use isopropyl alcohol or ethanol on any 
cytometer or fluidics cart surface. 
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Maintenance

This chapter describes the following maintenance procedures:

• Scheduled Maintenance on page 150

• Unscheduled Maintenance on page 159
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Scheduled Maintenance

For optimal cytometer functioning, perform the following maintenance 
according to the recommended schedule. Not following the scheduled 
maintenance procedures as listed can result in incorrect results or data not being 
detected. 

Procedure Description Frequency

Fluidics startup Replaces BD FACS shutdown 
solution with BD FACSFlow 
solution

See Chapter 4

Daily

Fluidics shutdown Replaces BD FACSFlow 
solution with BD FACS 
shutdown solution

See Chapter 9

Daily

Empty the waste — Daily and as needed

Wipe down the SIT and 
aspirator arm

Prevents saline deposit buildup

See Chapter 9

Daily

Empty the condensation 
trap on the fluidics cart

Prevents overflow of the 
condensation trap

See Chapter 9

Daily

Purge fluid filters Removes air from fluid filters, 
ensuring that they will not dry 
out

Weekly

Change the waste 
container cap

— Monthly

Clean fluidics (Long 
Clean)

Cleans the internal sheath path 
with BD FACS cleaning 
solution, then rinses with 
BD FACS shutdown solution

Monthly and before 
service calls



 Chapter 10: Maintenance 151

Replace the air filter Ensures proper cytometer 
performance

Every 6 months

Replace fluid filters Keeps fluids free of particulates Every 6 months or when 
increased debris is 
observed in FSC vs SSC 
plots

Schedule preventative 
maintenance by BD 
service

— Every 6 months

Procedure Description Frequency
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Emptying the Waste Container

Figure 10-1  Location of waste port on fluidics cart

1 Ensure that the cytometer is not acquiring events.

2 Detach the waste container’s sensor line and fluid line from the fluidics cart 
waste port (Figure 10-2 on page 153).

a Pull the sensor straight out.

b Press the metal clip on the fluid line.

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total volume) 
before disposal. Dispose of waste in accordance with local regulations. Use 
proper precautions and wear suitable protective clothing, eyewear, and 
gloves.

 

Waste port

Disposable 
waste cap

Trap

Waste tank
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Figure 10-2  Closeup of waste port

3 Remove the disposable waste cap and attached trap from the container. 
Place the assembly on the bench label-side up.

4 Empty the bleach-exposed waste.

5 Add approximately 1 L of bleach to the empty waste container (10-L 
container).

6 If one month has passed since the last cap change:

a Detach the cap from the trap.

The waste container can become pressurized when the cytometer is 
running. Always disconnect the container from the fluidics cart before you 
empty it. Wait at least 30 seconds for pressure to dissipate before you 
remove the waste cap or level sensor cap.

Do not wet the cap. If you see liquid inside the trap, treat it as 
biohazardous waste. Remove the drain plug and fully drain the liquid. 
Rinse the trap and drain plug with 10% bleach, followed by DI water. 
Replace the drain plug.

Sensor

Waste fluid line 
with metal clip
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b Replace it with a new cap.

c Write the date on the cap label.

7 Screw the cap assembly onto the waste container and hand-tighten until it 
is fully closed.

8 Re-attach the sensor line and fluid line.

Purging the Fluidics Filters

NOTE The cytometer must be on (system pressurized) during this procedure.

1 Prime the fluidics lines.

a Select Cytometer > Cleaning Modes > Prime After Tank Refill.

b Select all the checkboxes for the cubitainers.

c When the completion message appears, click OK.

2 Place a few paper towels beneath the filter to be purged.

3 Loosen the bleeder valve near the top of the filter by turning it 
counterclockwise. Do not completely unscrew the valve. If you do, it will 
come off.

To prevent waste container overpressurization, do not overtighten the trap 
or attached filter cap. Tighten each component only until it is hand-tight. 
Do not use sealants such as Teflon® tape or other adhesives.

338677 Rev A

Waste (A)

Space for 
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NOTE Do not loosen the bottom bleeder valve. Ensure that it is tightened.

4 Wait until fluid seeps out.

Fluid should seep from the open valve within 30 seconds. If no fluid 
appears, make sure that the corresponding cubitainer is not empty or 
detached from the cart. If the cubitainer contains fluid and the fluid lines 
are attached and primed, the filter might be airlocked. See Removing an Air 
Lock on page 164.

5 Close the bleeder valve by turning it clockwise.

6 Repeat steps 2 through 5 with the remaining filters.

Loosen this bleeder valve

DO NOT loosen this 
bleeder valve
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Cleaning the Fluidics System (Long Clean)

This procedure takes about 75 minutes to complete.

1 Check all fluid levels to make sure they are at least half full in order to 
complete the long clean. Fluid levels include FACSClean and Shutdown. 
Empty the waste if needed.

2 Select Cytometer > Cleaning Modes > Long Clean.

A confirmation dialog appears. 

3 Click OK to continue. Once you have begun the Long Clean, you cannot 
cancel the process.

4 Click OK when the completion message appears.

5 Select to shut down or continue.

• To shut down, exit the software and turn off the power to the 
cytometer.

• To continue, select Cytometer > Fluidics Startup.

If setup fails after a long clean, repeat Fluidics Startup until setup passes.

If the completion message has not appeared after 90 minutes, verify that 
there are no error messages in the Status tab of the Cytometer window. If 
the cleaning mode fails, see Fluidics Cart Troubleshooting on page 195.
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Replacing the Air Filter

1 Turn off the cytometer power.

2 On the door’s interior, turn the tabs located along the upper edge of the 
filter to release the old filter.

Dispose of the old filter. It cannot be reused.

3 Install a new filter. Ensure that the arrows etched on edges of the new filter 
point in toward the cytometer.



158 BD FACSCanto II Instructions For Use   

4 Turn the tabs to hold the filter.

Replacing Fluidics Filters

The fluidics cart should be on during this procedure.

1 Place a few paper towels beneath the filter.

2 Remove the filter by pressing the metal tabs on each quick-disconnect 
coupling (Figure 10-3).

Figure 10-3  Removing the filter

3 Position the new filter and connect the couplings.

Write the replacement date on the filter so you will know when to replace 
it.

4 Loosen the top bleeder valve by turning it counterclockwise.

NOTE Do not loosen the bottom bleeder valve. Ensure that it is tightened.

5 Wait until fluid seeps out.

Quick-
disconnect 

Metal tab

Metal tab

Loosen this 
bleeder valve

FLOW
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Fluid should seep from the open valve within 30 seconds. If no fluid 
appears, ensure that the corresponding cubitainer is not empty or detached 
from the cart. If the cubitainer contains fluid and the fluid lines are 
attached and primed, the filter might be airlocked. See Removing an Air 
Lock on page 164.

6 Close the bleeder valve by turning it clockwise.

Repeat the procedure for other fluid filters to be replaced.

Unscheduled Maintenance

Perform these maintenance procedures as indicated in the table.

Procedure Description When to Perform

Replace cubitainers — As needed

Prime fluid lines Removes air from fluid lines Whenever a fluidics line 
is disconnected to 
change a cubitainer or 
perform other 
maintenance

Remove an air lock Removes air from the filter and 
restores the flow of fluid

When fluidics are not 
functioning properly 
(the flow cell will not 
fill, or there is backflush 
into the sample tube)

Clean external surfaces Keeps surfaces free from salt 
buildup after exposure to 
sheath fluid

As needed

De-gas Flow Cell Removes bubbles from the 
flow cell

As needed during daily 
startup

Clean Flow Cell Runs BD FACS cleaning 
solution through the SIT and 
flow cell

When poor optical 
performance indicates 
additional cleaning is 
needed
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Bubble Filter Purge Removes air from the bubble 
filter

If fluidics run dry, or 
when CVs are poor

Clean the fluidics system 
for storage

Cleans out the fluidics lines 
with BD FACS cleaning 
solution, then fills them with 
BD FACS shutdown solution

Before long-term storage

Replace the Bal seal Replaces a worn Bal seal When the seal becomes 
worn or cracked (sample 
tubes will not 
pressurize)

Reconnect fluidics cart 
tubing

— As needed

Replace fluidics level 
sensors

— When instructed to by a 
BD Biosciences service 
representative

Procedure Description When to Perform
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Changing a Cubitainer

Three fluidics cubitainers (disposable boxes of approved fluids) and a waste 
container fit onto the cart in the following configuration.

Each cubitainer and the waste container have their own color-coded ports. To 
change a cubitainer:

1 Ensure that the cytometer is not acquiring events.

2 Detach the sensor and fluid line from the cart.

a Pull the sensor straight out.

BD FACS shutdown solution

Waste container

BD FACS cleaning solution

BD FACSFlow solution
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b Press the metal clip on the fluid line.

3 Unscrew the cap on the cubitainer.

4 Remove the cap and sensor assembly and set it aside.

You could damage the sensor line if you leave it connected while changing a 
cubitainer. 

Sensor

Metal clip
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I

5 Put a new cubitainer onto the fluidics cart.

6 Replace the cap assembly and hand-tighten it until it is fully closed.

7 Reattach the sensor line and fluid line to the cart.

• To attach the sensor line, gently rotate it until the connection aligns, 
and then push.

• To attach the fluid line, push the coupling into the port until it clicks.

8 Prime the fluidics.

Important: Continue with the procedure in Priming Fluidics Lines on 
page 164.

To ensure that the appropriate solutions are dispensed, match the label on 
the container to the port on the fluidics cart. 
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Priming Fluidics Lines

1 Select Cytometer > Cleaning Modes > Prime After Tank Refill.

2 Select the checkboxes for the cubitainers you changed. Click OK.

3 Click OK when the completion message is displayed.

NOTE If the fluidics are not functioning properly, perform Removing an 
Air Lock.

Removing an Air Lock 

1 Place a few paper towels beneath the air-locked filter.

2 Remove the filter by pressing the metal tabs.

Figure 10-4  Fluidics filter

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

Metal tab

Metal tab 
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3 Install bypass tubing in place of the filter.

4 Select Cytometer > Cleaning Modes > Prime After Tank Refill.

5 Select the checkbox that corresponds to the filter you have bypassed.

6 Click OK.

7 Ensure that fluid is moving through the bypass tubing.

8 When the prime finishes, remove the bypass tubing.

9 Reattach the filter to the fluidics cart.

10 Repeat the Priming Fluidics Lines procedure.

Bypass tubing, installed

BD FACSDiva softwareBD FACSCanto clinical software
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a Select Cytometer > Cleaning Modes > Prime After Tank Refill.

b Select the checkbox for the filter you bypassed.

c Click OK when the completion message is displayed.

11 Open the bleeder valve and wait for fluid to seep out. Close the valve.

If no fluid seeps out, repeat steps 10 and 11.

Figure 10-5  Bleeder valves on fluidics filter

Loosen this bleeder valve

DO NOT loosen this bleeder valve
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Cleaning External Surfaces

To prevent saline deposit buildup, wipe down all external cytometer surfaces that 
have been exposed to sheath fluid.

Cleaning Guidelines
 

NOTE Do not use BD FACS cleaning solution or bleach to clean or disinfect the 
barcode reader. See Cleaning the Barcode Reader on page 45.

Over time, saline deposits may develop on the interior surface of the SIT Bal seal 
retainer, causing an incomplete SIT flush between samples. If this occurs, you 
might need to remove and clean the retainer with DI water. See Figure 10-6 on 
page 170.

Cleaning Procedure

1 Switch off the cytometer power and unplug the AC power cord.

2 Wipe all accessible surfaces with BD FACS cleaning solution.

3 Wet a fresh cloth with DI water and wipe all solution or bleach-exposed 
surfaces to prevent corrosion.

4 Wipe all exposed surfaces with a clean, dry cloth.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

To prevent damage, do not use isopropyl alcohol or ethanol on any 
cytometer or fluidics cart surface. 

To avoid potential shock, always switch off the power and unplug the AC 
power cord before you begin cleaning.
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Removing Bubbles from the Flow Cell

1 Select Cytometer > Cleaning Modes > De-gas Flow Cell.

2 Click OK when the completion message is displayed.

3 Check the flow cell for bubbles.

If you still see bubbles, repeat the process. You might need to de-gas the 
flow cell several times.

Cleaning the Flow Cell

1 Select Cytometer > Cleaning Modes > Clean Flow Cell.

2 If you have a Loader installed, remove the carousel.

3 When prompted, manually install a tube containing approximately 2 mL of 
BD FACS cleaning solution onto the SIT, and click OK.

A progress message is displayed during the cleaning.

4 After the completion message is displayed, wait 5 minutes. 

Waiting allows BD FACS cleaning solution to dissolve deposits in the flow 
cell cuvette.

5 Click OK.

6 Remove the tube from the SIT.

7 Clear BD FACS cleaning solution from the flow cell and fluidics lines:

• Before running setup or samples, run Fluidics Startup.

• To shut down without running more samples, run Fluidics Shutdown.
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Purging the Bubble Filter

1 Select Cytometer > Cleaning Modes > Bubble Filter Purge (or Bubble Filter 
Purge and Degas Flow Cell).

2 Wait while the purge finishes.

3 Click OK when the completion message displays.

4 Repeat steps 1 through 3 until bubble-free liquid enters the flow cell from 
the bubble filter.

5 If you are using BD FACSCanto clinical software, after performing Bubble 
Filter Purge, select Cytometer > Cleaning Modes > De-gas Flow Cell. 

Cleaning the Fluidics System for Storage

1 Perform steps 1 through 4 in Cleaning the Fluidics System (Long Clean) on 
page 156.

2 Exit the software and turn off the power to the cytometer.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

BD FACSDiva softwareBD FACSCanto clinical software
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3 Wipe down the SIT and the aspirator arm with DI water. See Shutting 
Down on page 145 for more information.

Replacing the Bal Seal

Over time, saline deposits may develop on the interior surface of the SIT Bal seal 
retainer, causing an incomplete SIT flush between samples. Therefore, you should 
always rinse the retainer in DI water when you replace a Bal seal.

Figure 10-6  Bal seal and retainer

1 Turn off the cytometer.

2 If you have a Loader installed: 

a Open the Loader doors.

b Pull out the drawer.

c If needed, remove the carousel.

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

Retainer

SIT

Bal seal
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d Push the tube guide back to the manual position. Ensure that the tube 
guide is pushed back and the aspirator arm bar is in the vertical 
position.

3 Unscrew the retainer by turning it in the direction shown.

4 Lower the retainer down the SIT and let it rest on the aspirator arm.
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5 Access the Bal seal at the notch on the right side of the SIT assembly. 
Unseat the Bal seal by using the Bal seal removal tool to gently pull it 
downward.

6 Allow the Bal seal to slide down the SIT and rest on top of the retainer.

Bal seal removal tool

Bal seal
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7 Center the Bal seal on the retainer. With one hand, support the retainer and 
Bal seal and with the other hand, move the aspirator arm to the left. Lower 
the retainer and Bal seal from the SIT. 

See Figure 10-7.

Figure 10-7  Removing the Bal seal and retainer from the SIT

8 Hold the new Bal seal spring-side up (see figure), and slide it up the SIT. 
Use both hands to gently push it into its seated position. 

9 Rinse the retainer in DI water before replacing it on the SIT.

10 Reinstall the retainer over the SIT and tighten in the direction shown.

Bal seal, 
spring side up
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If the Bal seal is not seated firmly in position, replacing the retainer will seat 
it correctly.

11 Test the installation by manually loading a tube onto the SIT and running 
fluid.

12 If you are using a Loader, ensure that the system is ready for automatic 
loading. Move the tube guide into place on the SIT and move the aspirator 
arm bar to the back.
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Reconnecting the Fluidics Cart Tubing

The ports and connectors are color coded.

Figure 10-8  Cytometer and fluidics cart ports

Cytometer ports and their corresponding fluidics cart ports are listed in 
Table 10-1 on page 176. See Table 10-2 for port functions.

Air In

Communications

Sheath
(B)

Power Out

Fluidics Cart Connections

System Power

Waste (A)

     Auxiliary
Air Supply  (J)

On  (I)

Off  (O) Air In (F)

Air Out (G)Fluid (B)Circuit Breaker (T)

Voltage Selector (U)

Power (H)

Com (K)

Power from
Instrument
Power out only!

Waste (A)Waste (A)

Waste (A)Waste (A)

 9

Cytometer ports Fluidics cart ports

 8

10

11

12

13

14

15

16

17

 1

 2

 3

 4

 5

 6

 7
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Table 10-1  Correspondence of cytometer ports to fluidics cart ports

Port or Button on Cytometer Port on Fluidics Cart

1. System Power —

2. Power Out 12. Power In

3. Air In 15. Air Out (G)

4. Waste (A) 17. Waste (A)

5. Communications 13. Com (K)

6. Sheath (B) 9. Fluid (B)

7. Waste (A) 16. Waste (A)

— 8. On/Off

— 14. Air In (F)

Do not plug the fluidics cart power cord into a wall outlet. Plug the cord 
into the cytometer only. This ensures proper electrical grounding and 
protects against electrical shock or damage to the cytometer.

Table 10-2  Function of ports, buttons, and switches

Port or Switch Additional Information

1. System Power Powers both the cytometer and fluidics cart

2. Power Out Connects to the fluidics cart

3. Air In 70 ±5 psi

4. Waste (A) Waste out (aspirated)

5. Communications Data port

6. Sheath (B) BD FACSFlow solution port

7. Waste (A) Waste out (non-aspirated)

8. On/Off Auxiliary air supply switch. Keep in the off position unless 
connected to house air.
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Replacing the Fluidics Level Sensors

Before you replace a suspected faulty sensor, try rinsing it with DI water to 
restore operation.

1 Ensure that the cytometer is not acquiring events.

2 Detach the sensor and fluid line from the cart.

9. Fluid Out (B) BD FACSFlow solution port

10. Circuit breaker (T) Fluidics cart circuit breaker

11. Voltage selector (U) Fluidics cart voltage selector

12. Power In Connects to the cytometer. Do not connect to a wall outlet.

13. Com (K) Data port

14. Auxiliary Air In (F) No tubing on this port unless connected to house air

15. Air Out (G) Sends compressed air to the cytometer

16. Waste (A) Waste in (non-aspirated)

17. Waste (A) Waste in (aspirated)

If you are changing the sensor on the waste container, use proper 
precaution and wear suitable protective clothing, eyewear, and gloves. All 
biological specimens, and materials coming into contact with them, can 
transmit potentially fatal disease.

The waste container can become pressurized when the cytometer is 
running. Always disconnect the waste container from the fluidics cart and 
wait at least 30 seconds for pressure to dissipate before you remove the 
level sensor cap.

Table 10-2  Function of ports, buttons, and switches (continued)

Port or Switch Additional Information
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3 Unscrew the cap on the cubitainer.

4 Remove the level sensor assembly and discard into a suitable receptacle.

5 Put a new level sensor assembly on the cubitainer or waste container. 
Hand-tighten the cap until it is fully closed.

To ensure that the appropriate solutions are dispensed, make sure the label 
on the container matches the labeled port on the fluidics cart.
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Figure 10-9  Level sensor assemblies

6 Reattach the sensor line and fluidics lines.

7 If you replaced any level sensors (other than the waste sensor), prime the 
affected fluidics lines. Continue with the Priming Fluidics Lines procedure 
on page 164.

Waste level sensor 
(red connector)

BD FACSFlow level sensor 
(blue connector)

BD FACS cleaning solution and 
BD FACS shutdown solution 
level sensor (yellow connector)
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11

Troubleshooting

This chapter contains the following information, which will help you to 
troubleshoot issues that might arise when using this cytometer:

• Instrument Troubleshooting on page 182

• BD FACSCanto Clinical Software Troubleshooting on page 196

• BD FACSDiva Software Troubleshooting on page 215
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Instrument Troubleshooting

The instrument consists of the cytometer, the optional Loader, and the fluidics 
cart. The following sections provide tips for troubleshooting the instrument.

If you need additional assistance, contact BD Biosciences. Have the following 
information available: product name, catalog number, and serial number; any 
error messages; and details of recent system performance.

For cytometer support from within the US and Canada, call 877.232.8995. 
Customers outside the US and Canada, contact your local BD representative or 
distributor. See our website, bdbiosciences.com, for up-to-date contact 
information.

http://www.bdbiosciences.com
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Cytometer Troubleshooting

Observation Possible Causes Recommended Solutions

Flow cell will not fill Air in bubble filter For BD FACSCanto clinical 
software, run the Bubble Filter 
Purge command at least once (you 
might need to run it several times). 
When finished, run De-Gas Flow 
Cell.

For BD FACSDiva software, run 
the Bubble Filter Purge and De-
Gas Flow Cell command at least 
once (you might need to run it 
several times).

Fluidics cart power off Turn on the power to the fluidics 
cart by resetting the fluidics cart 
circuit breaker switch (Figure 1-7 
on page 27). Always use the 
cytometer power button, located 
on the left side of the cytometer, to 
turn the system off and on.

No pressure in the plenum Check the air supply components 
(see Figure 10-8 on page 175). 

• Check the air supply 
connections.

• Check the air supply tubing for 
kinks.

Sheath line disconnected 1 Check the cubitainer-to-fluidics 
cart and fluidics cart–to-
cytometer connections. See 
Reconnecting the Fluidics Cart 
Tubing on page 175.

2 Check the tubing for kinks.

BD FACSFlow cubitainer 
empty

Replace the BD FACSFlow 
cubitainer. See Changing a 
Cubitainer on page 161.
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Flow cell will not fill 
(continued)

Air in the BD FACSFlow filter 
(fluidics cart)

Purge air from the filter. See 
Priming Fluidics Lines on 
page 164.

Air lock in the BD FACSFlow 
filter (on fluidics cart)

See Removing an Air Lock on 
page 164.

No air pressure in the fluidics 
cart

• If the cart is attached to an 
auxiliary air supply, switch on 
the auxiliary air.

• If the cart is not attached to an 
auxiliary air supply, switch off 
the auxiliary air.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Fluid backfill into 
sample tube

Cracked or defective tube Data could be lost when 
transferring to a new 
tube. 

• If using a BD Trucount tube, do 
not transfer sample to a new 
BD Trucount tube because that 
would result in incorrect 
absolute counts. Re-stain the 
sample and use a new 
BD Trucount tube. 

• If using a non-BD Trucount 
tube, transfer sample to a new, 
non-BD Trucount tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 31.

Bal seal improperly installed 
or worn

Reinstall or replace the Bal seal. 
See Replacing the Bal Seal on 
page 170.

Air lock in BD FACSFlow 
filter

See Removing an Air Lock on 
page 164.

Tube partially removed from 
SIT after acquisition

Once you start to remove a tube 
from the SIT, complete the action.

Low laser power 
indication

Flow cell access door open Close the door completely.

Laser power output is below 
requirement

Call BD Biosciences.

Backflushing of sheath 
fluid into sample tube

Aspirator arm bumped or 
moved to side, but tube was 
not removed

1 Repeat the tube removal 
sequence.

2 Perform a manual SIT flush.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Fluidics pressure errors Air lock in filter Check the filter in the fluidics cart. 
Verify that the bottom bleeder 
valve on the filter is fully 
tightened. Open the top bleeder 
valve. If no fluid leaks out, remove 
the air lock as described in 
Removing an Air Lock on 
page 164.

Cytometer on, no 
response to software 
commands

Bad keyboard or mouse 
connection

Check the keyboard or mouse 
connections to computer. See the 
documentation that came with 
your workstation.

Communication failure 
between computer and 
cytometer

1 Turn off the computer and the 
cytometer.

2 Reseat the Ethernet cable, 
located next to the power cord 
on the right side of the flow 
cytometer.

3 Turn on the cytometer, then the 
computer.

User-installed firewall • Contact your system 
administrator to open a port in 
the firewall for the cytometer.

• Call BD Biosciences.

QC fails after Long 
Clean

Residual BD FACS cleaning 
solution in lines

Run Fluidics Startup to flush the 
system with sheath fluid. Repeat 
until QC passes.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions

RS-232 cable

Ethernet cable
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Tube does not load, or 
sample tube does not fit 
snugly on SIT

Improper tubes used Use only uncapped 12 x 75-mm 
Falcon polystyrene test tubes, 
BD Trucount tubes, and BD FACS 
7-color setup beads tubes. See 
System Requirements on page 31.

Defective or cracked tube Data could be lost when 
transferring to a new 
tube. 

• If using a BD Trucount tube, do 
not transfer sample to a new 
BD Trucount tube because that 
would result in incorrect 
absolute counts. Re-stain the 
sample and use a new 
BD Trucount tube. 

• If using a non-BD Trucount 
tube, transfer sample to a new, 
non-BD Trucount tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 31.

Bal seal improperly installed 
or worn

Reinstall or replace the Bal seal. 
See Replacing the Bal Seal on 
page 170.

Cytometer and fluidics 
cart will not turn on

Power cord disconnected 
from wall socket or cytometer

Reconnect the power cord to the 
wall socket or the cytometer.

Cytometer circuit breaker 
tripped

Switch on the cytometer circuit 
breaker, followed by the 
cytometer power (if off).

Blown fuse in cytometer 
controller

Turn off the cytometer main 
power and call BD Biosciences.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Fluid leaking from SIT or 
aspirator arm

Interior valve failure or leak 1 Turn off the cytometer power.

2 Clean up the liquid, using 
proper precautions.

3 Call BD Biosciences.

Waste line to fluidics cart 
disconnected

1 Turn off the cytometer power.

2 Clean up the liquid, using 
proper precautions.

3 Check that waste lines are 
securely plugged in.

4 Turn on the cytometer power.

Liquid leakage around 
cytometer base

Interior valve failure 1 Turn off the cytometer power.

2 Clean up the liquid, using 
proper precautions.

3 Call BD Biosciences.

Aspirator arm locked, 
cannot unload tube

Software not responding Do not use force to remove 
tube from the SIT.

1 Press Ctrl+Alt+Delete to open 
Task Manager.

2 Select End Task to close the 
BD FACSCanto clinical 
software or BD FACSDiva 
software application.

3 Restart the software and 
unload the tube.

Pressure loss Verify that the fluidics cart is 
powered on and that air pressure 
hoses are properly connected.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Fluidics error after 
replacing sheath fluid or 
emptying waste

Status change not yet detected 
by software

After replacing or emptying fluids, 
wait until the software detects a 
status change before restarting 
acquisition.

It can take up to 30 seconds for 
the software to detect a fluid level 
change.

Cytometer Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Loader Troubleshooting

Observation Possible Causes Recommended Solutions

Tube does not load Tube not completely raised Ensure that the Loader drawer is 
completely shut.

Ensure that the tube is free of 
bulky labels or tape.

Tube lifter hitting carousel 
during ascent

Ensure that the carousel is 
properly engaged with the 
alignment guide pin. If the 
problem persists, contact BD 
Biosciences for assistance.

Tube lifter failure Contact BD Biosciences.
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Tube does not unload Tube lifter failure 1 Log out and close BD 
FACSDiva software.

2 If the lifter remains in the up 
position, turn off the cytometer 
power for approximately 5 
minutes.

3 If the lifter still remains in the 
up position, contact BD 
Biosciences.

4 If the lifter returns to the down 
position, remove the Loader 
cover and the carousel.

5 Clean salt buildup from the 
base of the tube lifter.

6 Restart the cytometer and log 
in to BD FACSDiva software.

7 Replace the carousel and the 
Loader cover.

If the problem persists, contact 
BD Biosciences.

Status change not yet detected 
by software

After replacing or emptying fluids, 
wait until the software detects a 
status change before restarting 
acquisition.

It can take up to 30 seconds for 
the software to detect a fluid level 
change.

Loader Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Tube missed, or missing 
tube messages in 
software

Salt crystal buildup on optical 
sensors

Clean the tube optical sensor 
(outer sensor), as described in 
Cleaning External Surfaces on 
page 167.

Condensation on tube Wipe the tube.

Tube label reflection Turn the tube.

Tube not detected Optical sensor is wet or dirty 1 Clean the sensor.

2 Allow time for the sensor to 
dry.

Loader stalls or emits a 
grinding noise

Door opened during Loader 
initialization

When the Loader stops moving, 
open and close the Loader doors.

Do not open the Loader doors 
while the Loader is in motion.

Tube runs dry, Loader 
not advancing to next 
sample

Dilute sample or rare events Set a stopping time in 
BD FACSDiva software. See 
Chapter 7, Running Samples with 
BD FACSDiva Software.

Bubble in flow cell diverts 
stream

De-gas the flow cell. See 
Removing Bubbles from the Flow 
Cell on page 168.

Communication error 1 Restart the system.

2 Perform Fluidics Startup.

See Chapter 4, Starting Up.

Loader Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Test tube stuck on SIT, 
software not responding

• Cytometer not set up for 
automatic loading

• Software problem

Remove the tube from the SIT 
manually.

1 Hold the tube and move the 
aspirator arm aside.

2 Gently pull the tube off the SIT.

3 Release the aspirator arm.

4 Restart the software.

5 If needed, modify the cytometer 
for automatic loading.

Carousel not rotating 
correctly

Carousel not engaged with 
alignment pin on drawer

Rotate the carousel on the spindle 
until the alignment guide pin 
engages with the alignment hole, 
and press down. See Figure 8-5 on 
page 137. If the problem persists, 
contact BD Biosciences for 
assistance.

Aspirator arm bar vertical Rotate the bar to the forward 
horizontal position. 

Loader Troubleshooting (continued)

Observation Possible Causes Recommended Solutions
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Disabling the Loader in BD FACSCanto Clinical Software

If a problem occurs that requires you to temporarily disable the Loader and run 
tubes manually, you can make the software behave as though a Loader is not part 
of your system. Dialogs reminding you to insert the Loader, and other software 
notifications, no longer are displayed.

NOTE You can only make this change if you are logged in as the Lab Manager.

1 In BD FACSCanto clinical software, select Tools > Options.

2 Click the Run button.

3 Select the Ignore loader, always load tubes manually checkbox in the Run 
Options dialog.

4 Click OK.
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Fluidics Cart Troubleshooting

Observation Possible Causes Recommended Solutions

Water leakage around 
fluidics cart base

• Normal condensation 
overflow from pressure 
relief valve

• Extremely humid climate

1 Turn off the cytometer power.

2 Clean up the water.

3 Empty the condensation trap in 
the fluidics cart daily. See 
Figure 1-6 on page 25.

Bleeder valve on fluidics cart 
filter open

1 Turn off the cytometer power.

2 Clean up the liquid.

3 Check and close all bleeder 
valves. See Purging the Fluidics 
Filters on page 154.

Broken fluid line Contact BD Biosciences.

Fluidics cart will not 
power on, cytometer on

Cart circuit breaker off Switch on the fluidics cart circuit 
breaker.

Auxiliary air supply switch is 
on, cart not normally 
connected to auxiliary air

Toggle the auxiliary air supply off. 
When auxiliary air is on, the cart’s 
own air pumps turn off.

Power cord from fluidics cart 
to cytometer disconnected

Connect both ends of the cord.
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BD FACSCanto Clinical Software Troubleshooting

Acquisition Indicator Lights

The acquisition indicator lights may provide important information when 
troubleshooting software related issues. Ensure that these lights are on (see 
Electronics on page 23). 

BD FACSCanto Clinical Software General Issues

Observation or Error 
Message

Possible Causes Recommended Solutions

Software not responding Software frozen If acquisition is in 
progress, data will be lost 
when you click End Task.

1 Press Ctrl+Shift+Esc. Locate 
BD FACSCanto clinical 
software in the Windows 
Task Manager. Click End 
Task.

2 Restart the software. To 
prevent carryover, perform 
Fluidics Startup before 
acquiring data by selecting 
Cytometer > Fluidics Startup.

Software does not 
connect to cytometer

BD FACSDiva software 
running

• Exit BD FACSDiva software.

OR

• In BD FACSDiva software, 
put the cytometer in standby: 
select Cytometer > Standby.

Cytometer power is off Turn the power on.

Internal firmware error Cycle the power on the 
cytometer.

Ethernet disconnected See page 186.
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Connection error 
messages

Various • Follow any message 
directions.

• Ensure that the cytometer 
power is on.

• Check the Ethernet cable 
connection to the cytometer 
and computer.

• Verify that the fluidics cart is 
plugged in and the power is 
on.

• Exit the software, shut down 
the computer and cytometer, 
and then restart them.

Barcode reader error Dirty barcode reader 
window

Clean the barcode reader 
window with isopropyl or ethyl 
alcohol and try again.

Blurred or damaged 
barcode label

Try scanning with a duplicate 
label (if available), or enter the 
data manually.

BD FACSCanto Clinical Software General Issues 

Observation or Error 
Message

Possible Causes Recommended Solutions
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Tube not present error Tube not seated on SIT Push the tube all the way up 
onto the SIT.

Cracked or defective 
tube

Data could be lost 
when transferring to a 
new tube. 

• If using a BD Trucount tube, 
do not transfer sample to a 
new BD Trucount tube 
because that would result in 
incorrect absolute counts. 
Re-stain the sample and use a 
new BD Trucount tube. 

• If using a non-BD Trucount 
tube, transfer sample to a 
new, non-BD Trucount tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 31.

Fluid at top of tube 
prevents detection

Wipe the inside top of the tube 
with a clean cotton swab. 
Dispose of the swab with 
biohazardous materials.

Tube sensor wet or 
damaged

• Allow time for the sensor to 
dry.

• Reduce solution volumes to 
≤3 mL.

• Call BD Biosciences.

BD FACSCanto Clinical Software General Issues 

Observation or Error 
Message

Possible Causes Recommended Solutions
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Tube pressurization 
errors

Cracked or defective 
tube

Data could be lost 
when transferring to a 
new tube. 

• If using a BD Trucount tube, 
do not transfer sample to a 
new BD Trucount tube 
because that would result in 
incorrect absolute counts. 
Re-stain the sample and use a 
new BD Trucount tube. 

• If using a non-BD Trucount 
tube, transfer sample to a 
new, non-BD Trucount tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 31.

Drop at top of tube Dry the inside of the tube with a 
cotton swab and re-run.

Bal seal improperly 
installed or worn

Reinstall or replace the Bal seal. 
See page 170 for instructions.

Loader misaligned 1 Try running the cytometer in 
manual mode instead of 
automatic. See Running Setup 
Using Manual Loading on 
page 57 for converting to 
manual mode.

2 If unsuccessful, call 
BD Biosciences.

Wrong tubes used Make sure that you are using the 
recommended tubes. See System 
Requirements on page 31.

BD FACSCanto Clinical Software General Issues 

Observation or Error 
Message

Possible Causes Recommended Solutions
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Tube pressurization 
errors (continued)

Tubing to fluidics cart 
kinked or disconnected

Reconnect or straighten the 
tubing. See page 175.

Tube not detected Tube not seated on Bal 
seal properly

• Ensure that the tube is all the 
way up onto the Bal seal.

• Ensure that you are using 
appropriate tubes. See System 
Requirements on page 31.

• Replace or reinstall the Bal 
seal.

Vacuum error Tubing to fluidics cart 
kinked or disconnected

Reconnect or straighten the 
tubing. See page 175.

BD FACSCanto Clinical Software General Issues 

Observation or Error 
Message

Possible Causes Recommended Solutions
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BD FACSCanto Clinical Software Setup Wizard 
Messages

Messages Possible Causes Recommended Solutions

No acquisition events 
were received from 
cytometer

Communication problem 
between hardware and 
software

1 Turn on the power.

2 Connect the Ethernet cable to 
the cytometer and computer.

3 Exit the software, shut down 
the computer and cytometer, 
and restart them.

4 To prevent carryover, perform 
a Fluidics Startup before 
acquiring data. Select 
Cytometer > Fluidics Startup.

Bubbles in flow cell Check for bubbles. If found, run 
De-Gas Flowcell.

Laser failure Check the laser power in the 
Status window. If it is outside 
the acceptable range, call 
BD Biosciences.

Clogged SIT Clean the flow cell.

Failed to place [name of 
beads] on scale.

or

Failed to find [name of 
beads]

Bubbles in flow cell Check for bubbles. If found, run 
De-Gas Flowcell.

Software using saved 
settings from a failed 
setup

Delete the SetupResult.dat file 
from C:\ProgramData\BD\ 
Shared\Setup Results, and run 
the setup again.

No valid data points Internal setup error Delete the SetupResult.dat file 
from C:\ProgramData\BD\ 
Shared\Setup Results, and run 
setup again.
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A communication error 
was encountered

Communication problem 
between hardware and 
software

1 Turn on the power.

2 Connect the Ethernet cable to 
the cytometer and computer.

3 Exit the software, shut down 
the computer and cytometer, 
and restart them.

Fluidics cart off or 
disconnected

Switch on the fluidics cart circuit 
breaker. Make sure that the 
power cable is connected at both 
ends.

Cytometer setup was 
aborted by user

Setup aborted Perform setup again.

Cytometer setup was 
aborted because the 
loader doors were 
opened

Loader doors opened Perform setup again, keeping the 
Loader doors closed.

There is a vacuum error Vacuum tubing to waste 
cart disconnected

Reconnect the waste tank or 
tubing, and remove kinks.

Waste tank disconnected, 
waste tubing 
disconnected or pinched

Reconnect the waste tank or 
tubing, and remove kinks.

Clogged aspirator arm Call BD Biosciences.

BD FACSCanto Clinical Software Setup Wizard 
Messages (continued)

Messages Possible Causes Recommended Solutions
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There is a float switch 
error

Sheath tank not attached 
to fluidics cart

Reconnect the sheath cubitainer 
or tubing, and remove kinks. 

Sheath tubing from 
fluidics cart to cytometer 
not attached or pinched

Reconnect the waste tank or 
tubing, and remove kinks.

Sheath filter not primed Always prime after changing a 
cubitainer.

Fluidics air lock See Removing an Air Lock on 
page 164. 

Fluidics cart off or 
disconnected

Switch on the fluidics cart circuit 
breaker; make sure the power 
cable is connected at both ends.

Low or no pressure • Check the air supply 
connections.

• Check the air pressure gauge.

BD FACSCanto Clinical Software Setup Wizard 
Messages (continued)

Messages Possible Causes Recommended Solutions
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BD FACSCanto Clinical Software Setup Report 
Failure Messages

Failed Possible Causes Recommended Solutions

Detector voltage Bubbles in flow cell Check for bubbles. If found, run 
De-Gas Flowcell.

Wrong target value used Match the target values in the 
software to those printed on the 
BD FACS 7-color setup beads label. 
Re-enter them, if needed.

SetupResults.dat file 
deleted

Accept the failed setup, and then re-
run setup.

Sensitivity Bubbles in flow cell Check for bubbles. If found, run 
De-Gas Flowcell.

Dirty flow cell Clean the flow cell.

Spectral overlap Expired bead lot Run setup again with a fresh tube of 
setup beads.

Software using saved 
setting from a failed 
setup

Delete the SetupResult.dat file from 
C:\ProgramData\BD\Shared\
Setup Results, and run setup again.

Incorrect spectral 
overlap factors used

Match the spectral overlap factors 
in the software to those printed on 
the BD FACS 7-color setup beads 
label.

Laser power Laser failure Check the laser power in the Status 
window. If outside the acceptable 
range, call BD Biosciences.

Sheath pressure Kinked or clogged sheath 
line

Remove any kinks in the tubing to 
the fluidics cart.

Clogged or airlocked 
sheath filter

Check the sheath filter. Open the 
bleeder valves. If no fluid leaks out, 
remove the air lock.
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BD FACSCanto Clinical Software Levey-Jennings 
Errors and Messages

Observation Possible Causes Recommended Solutions

LJ plots empty, no data, 
no error message is 
displayed

BD FACS Setup Beads-7 
colors LJ.csv file missing

• If the file was renamed, 
rename it with its original 
name, and click Refresh.

• If the file was moved from the 
default directory, move it 
back, and then click Refresh.

LJ plots empty, no data, 
error message is 
displayed

BD FACS Setup Beads-7 
colors LJ.csv file 
corrupted or contains 
invalid data

Delete the BD FACS Setup 
Beads-7 colors LJ.csv file, and 
run setup again. The software 
will create a new set of plots.

BD FACS Setup Beads-7 
colors LJ.csv file open 
or in use by another 
application

1 Close the file or application.

2 Click Refresh.
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BD FACSCanto Clinical Software Acquisition

Observation Possible Causes Recommended Solutions

No events in plots after 
clicking Run, acquisition 
indicator lights are 
blinking as expected

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 

Detector voltage too 
low

Increase the voltage. 

No events in plots after 
clicking Run; acquisition 
indicator lights, except 
for those corresponding 
to threshold parameters, 
are blinking as expected

Threshold too low or 
too high

Adjust the threshold.

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 

No events in plots after 
clicking Run, 
NO acquisition indicator 
lights are blinking (no 
fluorescence signal)

Cracked or defective 
tube

Data could be lost 
when transferring to a 
new tube. 

• If using a BD Trucount tube, 
do not transfer sample to a 
new BD Trucount tube 
because that would result in 
incorrect absolute counts. Re-
stain the sample and use a 
new BD Trucount tube. 

• If using a non-BD Trucount 
tube, transfer sample to a 
new, non-BD Trucount tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 31.

SIT clogged Clean the flow cell.

Current cytometer 
configuration different 
from optical setup

Verify that the cytometer 
configuration corresponds to the 
cytometer’s optical setup.

Laser delay set 
incorrectly

Contact BD Service.
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Incorrect results/data not 
detected

Wrong panel was 
selected

Check the panel selection; make 
sure the plot parameters are 
appropriate for your assay.

A BD Trucount panel 
was selected when there 
was no BD Trucount 
tube

Re-run the sample and select a 
panel without BD Trucount 
tubes listed. 

BD FACSCanto Clinical Software Acquisition 

Observation Possible Causes Recommended Solutions
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A panel with no 
BD Trucount tube was 
selected when there was 
a BD Trucount tube

Re-run the sample and select a 
panel with BD Trucount tubes 
listed.

Expired BD FACS 
7-color setup beads 
used

Redo with current BD FACS 
7-color setup beads.

Incorrect absolute count 
results

Incorrect hematology 
results were entered in 
the worklist

Enter correct hematology results 
in the worklist and rerun the 
sample.

Unexpectedly high event 
rate

Threshold too low Increase the threshold. 

Sample too 
concentrated

Dilute the sample. 

Bubbles in flow cell Check for bubbles. If found, run 
De-Gas Flowcell.

Unexpectedly low event 
rate

Threshold too high Decrease the threshold.

SIT clogged Clean the flow cell.

Excessive amount of 
debris in plots

Threshold too low Increase the threshold. 

Dead cells or debris in 
sample

Examine the sample under a 
microscope.

Stained sample too old Check the reagent package 
insert.

FCS file not created PC hard disk full 1 Delete unnecessary files.

2 Run disk utilities regularly.

BD FACSCanto Clinical Software Acquisition 

Observation Possible Causes Recommended Solutions
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Acquisition stops High event rate 
(>10,000 events/sec) 
with more than 
8 compensated 
parameters

• Increase the threshold.

• Decrease the voltage on the 
threshold parameter.

• Dilute the sample.

• Define only parameters of 
interest in the parameters list.

Distorted populations or 
unexpected pattern in 
plot

Cytometer settings 
adjusted incorrectly

Optimize the scatter parameters.

Bubbles in flow cell Check for bubbles. If found, run 
De-gas Flowcell.

Flow cell dirty Clean the flow cell.

SIT not cleaned between 
tubes

Select Cytometer > Cleaning 
Modes > SIT Flush.

Incorrect gating Verify the gating.

BD FACSCanto Clinical Software Acquisition 

Observation Possible Causes Recommended Solutions
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BD FACSCanto Clinical Software TBNK Analysis 
QC Messages

Message Possible Causes Recommended Solutions

Sample quality 
questionable

Donor-specific anomaly Adjust gates manually to include 
required subsets. 

Insufficient mixing 
during sample 
preparation: cell 
populations elongated in 
CD3 vs SSC and FITC vs 
PE plots

Re-stain the sample. Vortex after 
the blood and reagent are added 
to the tube. Make sure that no 
blood remains on the side of the 
tube.

Sample not lysed 
adequately: cell 
populations in CD45 vs 
SSC extend upward

Prepare the sample again, 
ensuring complete lysis.

Aged blood and/or 
stained sample: 
granulocytes have low 
side scatter in CD45 vs 
SSC plot. No distinct 
monocyte population

See the information supplied 
with the reagent for stability 
limitations.

Excessive mixing: debris 
encroaching on 
populations in CD45 vs 
SSC plot

Re-stain the sample and run it 
again.

Low voltage for SSC 
detector 

Increase the SSC voltage and run 
the sample(s) again.

Various Look at the dot plots in 
BD FACSCanto Clinical 
Software Four- and Six-Color 
TBNK on page 212. Re-run the 
sample.

Sample not mixed 
properly

Vortex prior to loading the 
sample onto the SIT.
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Insufficient beads 
acquired (<500) 

Cell concentration too 
high

Dilute the sample, re-stain, and 
run it again.

% T-sum failure Large number of double-
positive or double-
negative T cells

Inspect the gates and include all 
required events. Adjust gates 
manually, if needed.

Lymphosum failure Events incorrectly 
classified as T, B, or NK

Inspect the gates and make sure 
that required events are 
included. Adjust gates manually, 
if needed.

Laser power low during 
recording: Visually 
inspect.

Data collected with low 
laser power

Inspect the data. 

If the power is outside the 
acceptable range, call 
BD Biosciences.

Lymph gate failure: gate 
manually.

No usable lymph gate • Adjust the lymph gate 
manually.

• If necessary, run the sample 
again.

BD FACSCanto Clinical Software TBNK Analysis 
QC Messages (continued)

Message Possible Causes Recommended Solutions
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BD FACSCanto Clinical Software Four- and Six-Color 
TBNK

Observation Possible Causes Recommended Solutions

Cell populations in 
CD45 vs SSC extend 
upward

Inadequate lysing of 
sample

Prepare the sample again, and 
ensure complete lysis.

Granulocytes with low 
side scatter in CD45 vs 
SSC plot, no distinct 
monocyte population

Aged blood or stained 
cells

See the reagent package insert 
for stability limitations.
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Debris encroaching on 
populations in CD45 vs 
SSC plot

Excessive mixing Prepare the sample again.

Aged blood or stained 
cells

Prepare the sample again.

Vertically compressed 
populations

Side scatter too low Reacquire the sample. Set SSC 
so granulocytes reach to top of 
the CD45 vs SSC plot.

Lipemic sample Check the reagent package 
insert for instructions.

BD FACSCanto Clinical Software Four- and Six-Color 
TBNK (continued)

Observation Possible Causes Recommended Solutions
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Indistinct populations. 
Events sparse or missing 
from one population. 
Lack of separation 
between CD3– and 
CD3+ cluster

Incorrect spectral overlap Re-run setup, optimizing for the 
application. Re-run the sample.

Granulocytes cut off at 
top of plot; stretched 
monocyte population

High SSC Re-run setup, optimizing for the 
application. Re-run the sample, 
lowering the SSC.

BD FACSCanto Clinical Software Four- and Six-Color 
TBNK (continued)

Observation Possible Causes Recommended Solutions
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BD FACSDiva Software Troubleshooting

Acquisition Indicator Lights

The acquisition indicator lights may provide important information when 
troubleshooting software related issues. Ensure that these lights are on (see 
Electronics on page 23).

BD FACSDiva Software General Issues

Observation Possible Causes Recommended Solutions

Cytometer 
Disconnected in 
Cytometer window

(software does not 
connect to cytometer)

BD FACSCanto clinical 
software running

• Exit BD FACSCanto clinical 
software.

• In BD FACSCanto clinical 
software, put the cytometer in 
standby: select Cytometer > 
Standby.

Cytometer power is off Turn the power on.

Internal firmware error Cycle the power on the cytometer.

Communication failure 
between software and 
cytometer

• Exit the software and restart it. 

• If unsuccessful, cycle the 
cytometer power. Restart the 
computer.

Ethernet cable 
disconnected 

Unplug and then plug in the cable 
connectors. 

Cytometer not 
responding 
status message

Various Switch the cytometer power off, 
and then on. Restart the computer. 
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Unable to access 
database

Adaptive Server 
Anywhere™ not 
running

Verify that the database server has 
been started.

1 Select Start > Settings > Control 
Panel and double-click the 
Administrative Tools icon.

2 Double-click the Services icon. 

3 Select Adaptive Server 
Anywhere. If the Start button is 
available, click the button to 
start the database server. If the 
buttons are dimmed, the 
database could be loading. 

Software not 
responding

Saving or loading large 
data file

Look for screen activity. If there is 
no activity, wait 1–2 minutes, and 
then restart the software.

Calculating large 
number of statistics

Calculating statistics is memory 
intensive. When calculating many 
statistics on a large number of 
displayed events, wait 1–2 minutes 
before using the software. 

Waiting for response 
from cytometer

Wait until the cytometer action is 
complete. If after 2 minutes no 
timeout is received, restart the 
cytometer and software.

After restarting the software, to 
prevent carryover, perform a 
Fluidics Startup before acquiring 
data:

Select Cytometer > Fluidics 
Startup.

Software message 
Hardware key not 
accessible...

Security module 
disconnected

Reconnect the security module to 
the USB port, and restart the 
software.

BD FACSDiva Software General Issues (continued)

Observation Possible Causes Recommended Solutions
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Error message in 
Status tab

(See text in error 
message)

Follow instructions in the error 
message.

Communication or 
fluidics error

Shut down the computer and 
cytometer, and restart them. If the 
message is displayed again, contact 
technical support. Provide the 
exact wording of the status 
message.

Faulty screen display, 
display objects 
distorted or unreadable

Non-standard DPI 
setting

Revert to the default DPI:

Right-click the desktop and select 
Properties. Click the Settings tab. 
Click the Advanced button. With 
the General tab selected, use the 
menu to set the DPI to 96 (normal 
size).

BD FACSDiva Software General Issues (continued)

Observation Possible Causes Recommended Solutions
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BD FACSDiva Software Cytometer Setup

Observation Possible Causes Recommended Solutions

Error creating 
compensation tubes

Naming conflict with 
existing tube or 
worksheet

1 Locate the tube or worksheet 
named (ParameterName) 
Stained Control, and change 
the name. 

2 Create the compensation 
tubes again.

Error calculating 
compensation

PMT voltages 
inconsistent between 
compensation tubes

Re-record all compensation 
tubes with the same PMT 
settings.

Wrong tube run for 
stained control tube

Re-record all compensation 
tubes and recalculate. 

Insufficient separation 
between positive and 
negative populations

Adjust compensation to see if it 
improves. If it does not, re-
record the compensation tubes, 
draw new gates, and calculate 
compensation again.

If automatic compensation fails, 
perform manually.

BD FACSDiva Software Acquisition

Observation Possible Causes Recommended Solutions

No events in plots after 
clicking Acquire, 
acquisition indicator 
lights are blinking as 
expected (viewing 
normal worksheet)

Current tube pointer not 
on current tube

Move the current tube pointer in 
front of the appropriate tube.

Viewing plots for a 
different tube

Double-click the current tube in 
the Browser to display the plots 
for that tube.

Incorrect population(s) 
in plot

Right-click the plot and select 
Show Populations. Inspect the 
populations.
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(Viewing normal or 
global worksheet)

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 

Detector voltage too low Increase the voltage. 

No events in plots after 
clicking Acquire. 
Acquisition indicator 
lights, except for those 
corresponding to 
threshold parameters, 
are blinking as expected.

Threshold too low or 
too high

Adjust the threshold.

Threshold not set to 
correct parameter

Set the threshold to the correct 
parameter for your application. 

BD FACSDiva Software Acquisition (continued)

Observation Possible Causes Recommended Solutions
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No events in plots after 
clicking Acquire, 
NO acquisition indicator 
lights are blinking

Cracked or defective 
tube

Data could be lost 
when transferring to a 
new tube. 

• If using a BD Trucount tube, 
do not transfer sample to a 
new BD Trucount tube 
because that would result in 
incorrect absolute counts. 
Re-stain the sample and use a 
new BD Trucount tube. 

• If using a non-BD Trucount 
tube, transfer sample to a 
new, non-BD Trucount tube.

• Make sure you are using 
appropriate tubes. See System 
Requirements on page 31.

SIT clogged Clean the flow cell.

Current cytometer 
configuration different 
from optical setup

Verify that the cytometer 
configuration corresponds to the 
cytometer’s optical setup. If it 
does not, contact your System 
Administrator.

Incorrect sample 
preparation

Re-stain and re-run samples.

Indicator light switch off Turn the indicator light switch 
on.

Laser delay set 
incorrectly

Contact your lab manager to 
correct the laser delay settings.

Area scaling factor set 
incorrectly

Contact your lab manager to 
correct the area scaling factor 
settings.

BD FACSDiva Software Acquisition (continued)

Observation Possible Causes Recommended Solutions



 Chapter 11: Troubleshooting 221

Fluorescence signal 
missing

Current cytometer 
configuration different 
from optical setup

Verify that the cytometer 
configuration corresponds to the 
cytometer’s optical setup, and 
the parameter list includes 
appropriate parameters.

Laser delay set 
incorrectly

Contact your lab manager to 
correct the laser delay settings. 

Area scaling set 
incorrectly

Contact your lab manager to 
correct the area scaling settings. 

Fluorescence threshold 
set too high

Adjust the threshold.

Incorrect sample 
preparation

Re-stain and re-run samples.

Unexpected results after 
clicking Next

Current tube pointer on 
wrong tube

Put the current tube pointer in 
front of the appropriate tube 
before clicking Next.

Unexpectedly high event 
rate

Threshold too low Increase the threshold. 

Sample flow rate too 
high

Decrease the flow rate.

Bubbles in flow cell Check for bubbles. If found, run 
De-Gas Flowcell.

Unexpectedly low event 
rate

Threshold too high Decrease the threshold. 

Erratic event rate Sample aggregates Filter the sample.

Distorted scatter 
parameters 

Cytometer settings 
adjusted incorrectly

Optimize the scatter parameters. 

Bubbles in flow cell Check for bubbles. If found, run 
De-Gas Flowcell.

BD FACSDiva Software Acquisition (continued)

Observation Possible Causes Recommended Solutions



222 BD FACSCanto II Instructions For Use   

Excessive amount of 
debris in plots

Threshold set too low Increase the threshold. 

Dirty sheath filter Replace the sheath filter.

Dirty flow cell Clean the flow cell. See 
page 168.

High CVs Sample flow rate too 
high

Decrease the flow rate.

Window extension set 
incorrectly

Contact the lab manager to set 
the window extension to 7.0.

Acquisition stops High event rate 
(>10,000 events/sec) 
with more than 
8 compensated 
parameters

• Increase the threshold.

• Decrease the voltage on the 
threshold parameter.

• Dilute the sample.

• Define only channels of 
interest in the parameter list.

Fewer events than 
expected in gated 
population

Window extension set 
incorrectly

Contact the lab manager to set 
the window extension to 7.0.

On-axis events left out 
of gate

Include events on the axis.

Gates improperly set Check the gating strategy.

Dirty sheath filter Replace the sheath filter.

Dirty flow cell Clean the flow cell. See 
page 168.

High electronic abort 
rate (>10% of system 
event rate)

Event rate too high Decrease the flow rate.

Sample too concentrated Dilute the sample.

Threshold set too low Increase the threshold.

Window extension set 
incorrectly

Contact the lab manager to set 
the window extension to 7.0.

BD FACSDiva Software Acquisition (continued)

Observation Possible Causes Recommended Solutions
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Increasing threshold 
results in decreased area 
signal

Window extension set 
too low

Contact the lab manager to set 
the window extension to 7.0.

Area measurement off-
scale while height 
measurement is on scale

Area scaling set too high Contact your lab manager to 
correct area scaling settings.

BD FACSDiva Software Acquisition (continued)

Observation Possible Causes Recommended Solutions
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Appendix A

Technical Specifications

This appendix contains information for the following specifications:

• Cytometer Specifications on page 226

• Fluidics Cart Specifications on page 231

• BD FACS Loader Specifications on page 232

For barcode reader specifications, see the information supplied by the 
manufacturer.
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Cytometer Specifications

Description Specification

Dimensions Height: 64 cm (25.2 in.)

Width: 91 cm (35.7 in.)

Depth: 61 cm (24 in.) 

Workspace dimensions Height (with flow cell access door open): 85 cm (33.5 in.)

Unit designed to fit a lab bench 55.9 cm (22 in.) deep.

Operational clearances, 
cytometer

Left side: 30 cm (11.8 in.) between the unit and other 
objects or a wall to permit proper air flow and access to the 
main power button and circuit breaker

Right side: 30 cm (11.8 in.) between the unit and other 
objects or a wall to permit proper air flow

Top: 22.5 cm (8.9 in.) between the unit and other objects or 
a wall to permit opening of the flow cell access door

Weight Less than or equal to 146 kg (320 lb), cytometer only, 
excluding the Loader and computer

Maximum 168 kg (370 lb), including the Loader

Power requirements 100/115/230 VAC (50–60 Hz)

Current: 

5 A at 115 VAC 

2.5 A at 230 VAC

Power consumption 500 W
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Environment

Performance

Description Specification

Storage temperature 5–40°C (41–104°F)

Operating temperature 16–31°C (59–86°F)

Operating relative humidity 20–80% (noncondensing)

Noise level Less than or equal to 62 dBA

Facilities No special room requirements

Description Specification

Fluorescence threshold sensitivities FITC <100 MESF
PE <50 MESF

Forward and side scatter sensitivity Platelets can be resolved from noise

Forward scatter sensitivity 1 micron

Side scatter sensitivity 0.5 micron
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Optics

Laser Specifications

The following Class 3B lasers are mounted on the BD FACSCanto II cytometer.

These lasers are contained within the cytometer. Therefore the BD FACSCanto II 
flow cytometer is a Class 1 laser product.

Excitation Optics

Laser Wavelength (nm) Power (mW)

Blue 488 20

Red 633 17

Violet 405 30

Description Specification

Optical platform Fixed optical assembly

Beam geometry (all lasers) 9 x 65-µm elliptical beam
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Emission Optics

Description Specification

Collection lens Optical gel-coupled to flow cell

Numerical aperture (NA) = 1.2

Fluorescence detection 6 to 8 photomultiplier tube detectors:

Wavelength ranges detected from the 488-nm laser:

• 750–810 nm (PE-Cy7)

• 670–735 nm (PerCP-Cy5.5)

• 610–637 nm (PE-Texas Red®, optional)

• 564–606 nm (PE)

• 515–545 nm (FITC)

Wavelength ranges detected from the 633-nm laser:

• 750–810 nm (APC-Cy7)

• 701–723 nm (Alexa Fluor® 700, optional)

• 650–670 nm (APC)

Wavelength ranges detected from the 405-nm laser:

• 502–535 nm (AmCyan)

• 425–475 nm (Pacific Blue™)

Forward scatter detection Photodiode with 488/10 bandpass filter

Side scatter detection PMT with 488/10 bandpass filter
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Fluidics

Signal Processing

Description Specification

General operation Integrated fluidics cart with automated startup, 
shutdown, and cleaning cycles

Sheath consumption 1.1 L/h, normal operation

Less than1.0 mL/h, standby

Sample flow rates Assay dependent, controlled automatically by 
BD FACSCanto clinical software. Nominal rates:

Low = 10 µL/min

Medium = 60 µL/min

High = 120 µL/min

Sample acquisition rate 10,000 events/sec with <10% abort rate 
(8 parameters)

Recommended maximum 
particle size

50 µm

Description Specification

Workstation resolution 262,144-channel resolution

Data acquisition channels 8 to 10 parameters: 6 to 8 fluorescence and 2 
scatter parameters

Fluorescence compensation No limit to inter- and intra-beam compensation

Pulse processing Height, area, and width measurements available 
for any parameter (BD FACSDiva software)

Time Can be correlated to any parameter

Channel threshold Available for any parameter from all lasers
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Fluidics Cart Specifications

Capacity

Description Specification

Dimensions Height: 64 cm (25.2 in.)

Width: 79 cm (31.1 in.)

Depth: 61 cm (24 in.)

Operational clearances Fluidics cart, side air vent: 20 cm (7.9 in.) between the air 
vent and other objects or a wall to permit proper air flow

Fluidics cart, door air vent: 20 cm (7.9 in.) between the door 
and other objects or a wall to permit proper air flow

Weight Less than or equal to 51 kg (112 lb), fluidics cart only, 
excluding tanks

Less than or equal to 82 kg (180 lb), with tanks full

Facilities No air supply or vacuum required

Description Specification

BD FACSFlow cubitainer 20 L

BD FACS cleaning solution cubitainer 5 L

BD FACS shutdown solution cubitainer 5 L

Waste tank 10 L
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BD FACS Loader Specifications

Description Specification

Carousel compatibility Loader carousels, numbers 1–16

Tube compatibility

• Carousel Accommodates up to 40 uncapped 12 x 75-mm 
tubes

• Falcon polystyrene test tubes

• BD Trucount tubes

• BD FACS 7-color setup bead tubes

• Thickness of accumulated 
labels

Less than or equal to 0.125 mm (5 mils) 
no more than 3 labels thick
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Appendix B

Assays

In the US, the following assays have been cleared for the BD FACSCanto II 
cytometer:

• BD Multitest™ 6-color TBNK with BD Trucount™ tubes

• BD Multitest™ 6-color TBNK without BD Trucount™ tubes

• BD Multitest™ IMK kit with BD Trucount™ tubes 

• BD Multitest™ IMK kit without BD Trucount™ tubes 

• BD™ HLA-B27

• BD™ Stem Cell Enumeration Assay 
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Index

Symbols

% T-sum failure 211

Numerics

7-color setup beads 32

A

aborts, electronic 222
acquisition

events to record 113
lag 86
manual mode 84
no events 206
optimizing during 87
stopping manually 142
troubleshooting 218
view 86
with Loader 136

Acquisition Dashboard 39
acquisition templates

creating 113
previewing data 123

Adaptive Server Anywhere See database.
adding

FCS files to worklists 95
samples to worklist 95

adjusting
cytometer settings 76
detectors 76
gates 91
PMT voltages 107
setup settings 72
spectral overlap 78
threshold 77, 107

air filter, replacing 157
alcohol, isopropyl 147, 167
analysis

immunophenotyping 113
reusing 123
saving 123
worklists 95

analysis objects
copying 123

application menus 34
area scaling, troubleshooting 223
assistance, technical xv
auto-gates, reapplying 92
auxiliary air supply switch 27

B

Bal seal 170
replacing 170
retainer 170
saline deposits 167
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barcode
reader 30

cleaning 45
BD FACS Loader 28
BD FACSDiva software

buttons 36
logging out 125
workspace components 36

beads
running setup 57
setup 56
spectral overlap factors 61
target values 61

beam geometry 228
bleeding filters 154
breaker, main circuit 23
Browser window 37
Bubble Filter Purge procedure 160
bypass tubing, installing 165

C

calculating compensation 110, 112
cap, waste container 153
carousel

controls 137
rack

compatible 29
described 29
ID 83
installing 135
loading 84
mixing preferences 133
removing 134
software setup 130
troubleshooting 193
tubes, compatible 29, 232

report 131
case number 82

changing
cubitainers 161
tubes 87

circuit breaker
cytometer 23
fluidics cart 27

resetting 187
cleaning

barcode reader 45
external surfaces 167
fluid 32, 147, 167

coefficient of variation (CV), high 222
compensation

calculating 110, 112
gating data 111
setup 112

components
BD FACSCanto II system 18
fluidics cart 25

computer
shutting down 146
starting 50

condensation trap 27
emptying 147

connectivity status 35
controls

cytometer 76
export file 83
process 83

cubitainer, changing 161
customer support xv
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cytometer
cleaning 167
controls 76
disconnect error 215
errors 202
not responding 215
not responding to software 186
settings, adjusting 76
setup 56
specifications 226
warning, objects on top of 18

Cytometer window 37

D

data
analyzing 113
gating 111, 113
recording 118

database
Adaptive Server Anywhere, not 

starting 216
decontamination 156
detector

adjusting 76
arrays

4-2 configuration 22
errors during setup 204

disabling Loader 194
display, troubleshooting 217
Diva software See BD FACSDiva 

software.
doors

Loader 136
dry tube, sample runs 192

E

electronic aborts 222
emitted light 20

error messages
check cytometer status 217
Cytometer Disconnected (from BD 

FACSDiva software) 215
Cytometer not responding 215
flow cell access door 53
Hardware key... 216

errors
cytometer 202
detector voltages 204
fluidics pressure 204
laser 204
setup 201
tube pressurization 199, 200
vacuum 200

ethanol 147, 167
events

not showing 201, 206
not showing in plots 218, 220
rate, troubleshooting 208
troubleshooting 222

Experiment Layout window 113
Experiments

immunophenotyping 113
sample optimization 103

F

FCS files
adding to worklist 95
not created 208

files
optimized setup 74, 75
process control 83

filters
air, replacing 157
bleeding 154
fluidic 25
purging 154
waste container cap 153
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flow cell
checking for bubbles 53
problems 183, 184

flow rates 230
appropriate 118

fluid
leaks

cytometer 188
fluidics cart 195
SIT 188

levels 51
not recommended 147, 167
required 32

fluidics
level

indicators 51
sensors, replacing 177

long clean 156
pressure errors 204
priming 164

fluidics cart
components 25
controls 27
dimensions 231
maintenance 152, 161
reconnecting tubing 175
troubleshooting 187, 195

fluorescence
detection 229
properties, particle 20
signal, troubleshooting 206, 221

G

gates, adjusting 91
gating

compensation tubes 111
data 113
manually adjusting 91
reapplying auto-gates 92

granularity, particle 20

H

hazard symbol definitions xiii

I

immunophenotyping
analysis 113
Experiment 113

importing worklists 114
in vitro diagnostic device xv
Inspector window 38
installing

air filter 157
bypass tubing 165
carousel rack 135
cubitainers 161
fluidics level sensors 177
tubes 62

instrument
specifications 231

Intended use xv
intended use statement xv
isopropyl alcohol 147, 167

L

Lab Reports
display time 90
reviewing 90, 93
viewing 87

label thickness 232
labels

parameter 113
thickness 232

lag, acquisition 86
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laser
errors 204
specifications 228
troubleshooting 185

leaks
cytometer 188
fluidics cart 195
SIT 188

level
fluid 51
sensor 177

light, scattered and emitted 20
Loader

about 28
disabling 194
doors, opening 136
for setup 66
mix settings 85
running cleaning tubes 143

loading tubes 62
logging out, software 100, 125
long clean 156
lymph gate failure 211
lymphosum failure 211

M

maintenance
barcode reader 45
scheduled 150
unscheduled 159

menu commands 34
mixing

Loader 85
preferences 133

moving gates 92

O

octagon optics 22
operating temperature 227

optics
filters and mirrors 22
octagon 22
trigon 22

optimization settings file 74, 75
optimizing during acquisition 87, 89

P

panels, choosing 82
parameters

adding or deleting 104
changing 104
labels 113
plot 87
scatter, distorted 221

particle
fluorescence properties 20
granularity 20
shape 20
size 20

photomultiplier tubes (PMTs), applying 
voltages 107

plenum 19
plots

adjusting gates 91
excessive debris 208, 222
no events 218, 220
parameters 87

populations, troubleshooting 222
preferences

mixing 133
user 124

pressure
errors, tube 199, 200
fluidics 204

priming, fluid lines 164
process controls 83
purging filters 154
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Q

QC
cytometer 56
messages 210

quality control (QC) 56

R

rack, carousel 232
recording

compensation tubes 110
data 118

removing
carousel rack 134
tubes 63

replacing
air filter 157
Bal seal 170

reports
Carousel 131
Lab

reviewing 90, 93
viewing 87

printing automatically 139
requirements, system 31
re-running

samples 139
tubes 93

results, unexpected 221
reviewing

Lab Reports 90, 93
running

process control 83
samples 84, 136
setup 57

S

sample injection tube (SIT) 
problems 185, 187

sample prep assistant (SPA) software
applying panel analysis on 

import 116
editing imported worklist 115
importing worklists 114
user preferences 114

samples
adding to worklist 95
ID 82
name 82
optimization 103
questionable quality 210
running 84, 118
skipping 94

saving
analyses 123
user-specific optimization 75
worklists 85

scaling, area, troubleshooting 223
scatter parameters, distorted 221
scattered light 20
scheduled maintenance 150
security module troubleshooting 216
sensitivity, cytometer performance 227
sensors, fluidics 177
settings

adjusting 76
default 75
multiple users 75
optimization, saving 75
single user 75
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setup
about 56
adjusting settings 72
age 56
beads 56
compensation 112
errors 201
failure 64, 68
manual mode 62
running 57
troubleshooting 201
using the Loader 66

shape, particle 20
sheath fluid consumption 230
shutting down computer 146
signals

no fluorescent 206, 221
troubleshooting 223

size, particle 20
skipping

samples 139
tubes 94

software
logging out 100
menus 34
not responding 196, 216
troubleshooting 196, 215

specifications
cytometer 226
fluidics cart 231
loader 232

spectral overlap
adjusting 72, 78
factors, beads 61

spillover, manual adjustment 78
starting computer 50
status bar 35
stopping acquisition manually 142
system requirements 31

T

target values, setup beads 61
technical assistance xv
technical specifications 232
threshold

adjusting 77, 107
troubleshooting 223

time
display (Lab Report) 90
pre-acquisition 86

timeout, unload tube 88
toolbar, workspace 36
trap, condensation 27

emptying 147
trigon optics 22
troubleshooting

acquisition 218
CVs 222
electronic aborts 222
event rate 208, 221
FCS files 208
general software 196, 215
no events 201, 206
plots 208, 218, 220, 222
populations 222
QC messages 210
scatter parameters 221
screen display 217
security key 216
setup 201
signals 206, 221, 223
status messages 217
window extension 223

Trucount tubes 83
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tubes
changing 87
compatible 29
loading 62
pressurization errors 199, 200
removing 63, 73, 88, 109, 110
re-running 93
skipping 94
timeout during unloading 88

U

unload tube timeout 88
unscheduled maintenance 159
USB security module 216
user preferences 124

V

vacuum error 200
viewing Lab Reports 87
views

Browser 37
Cytometer window 37
Worksheet 38
Worksheet window 38

voltage
adjusting PMT 107
compensation and 110

W

waste container
cap 153
emptying 152

window
Acquisition Dashboard 39
BD FACSDiva software 

workspace 36
Browser 37
Canto software components 34
Cytometer 37
extension, troubleshooting 223
Inspector 38
Worksheet 38

worklists
adding

FCS files 95
samples 95

analysis 95
importing 114
opening 96
saving 85

Worksheet window 38
workspace toolbar 36
workstation

shutting down 146
starting 50
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